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ABOUT THIS DOCUMENT

This Handout is intended to be used in conjunction with the RootsMagic Online Help, accessible
from within the RootsMagic program using the F1 key from anywhere in the program, from the
HOME Page and/or by selecting Help in the Options Menu found in the upper right corner of the
program window.

This Handout is the official repository for the supplemental information and personal
recommendations previded-by-the-SpeciaHnterest-Group-{SIG)-Facilitater-| have provided at the

monthly feruse-by-the Genealogical Forum of Oregon (GFO) RootsMagic SIG meetings and is
provided as a reference for SIG members.

| don’t currently use, and may never use, all of the features discussed in our SIG meetings in my

personal family research database. The purpose of this Handout is to supplement the information
found in the RootsMagic Online Help to make GFO SIG Members aware of ALL of RootsMagic’s
features and how they can be used, along with any undocumented limitations.

Recognizing one of the GFO RootsMagic’s SIG’s Operating Principles: There is no single “correct”

way to “do genealogy:;” the evaluation of each feature’s usefulness and the decision to utilize it as
part of each GFO Sig Member’s individual quest to do family research, is left to each SIG Member,
given their specific use case.

There may be errors in this Handout and some information may conflict with how each SIG Member
has decided to use RootsMagic. Therefore, use of the information in this Handout is at your own
risk.

This is a living document that is periodically updated as new sections are discussed in the monthly
SIG meetings, the software changes, the Online Help changes and/or new information about how
the existing version of the program works (or doesn’t). Very little information found in the Online
Help is repeated in this Handout.

When information included in this document is incorporated in the Online Help, it will be deleted
from this Handout. Currently, this document covers information for RootsMagic versions 9 and 10.
The latest version of this document can be found at the GFO RootsMagic SIG webpage:
https://gfo.org/learn/special-interest-groups/rootsmagic.html.

Barry Wolff
GFO RootsMagic SIG Facilitator

RootsMagic@gfo.org
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GENERAL

RootsMagic does not provide telephone support. Any information you find online about phone
support is a scam
RootsMagic Help is available via several means, all accessible from the HOME Page:
a. Online Help (F1 key) takes you to:
i.  RM9 Help: https://help.rootsmagic.com/RM9/index.html
ii. RM10 Help: https://help.rootsmagic.com/RM10/index.html
b. Technical Support
i.  Online Chat (M-F during normal work hours, Mountain time)
ii. Online Help Request submittal
c. RootsMagic Online Community
Help is also available via the FaceBook RootsMagic Users Group (private group, administered by
RootsMagic)
The following general data entry and navigation guidelines apply to many different areas in
RootsMagic:
a.  Whenever an “arrow” (greater than, less than, up and/or down symbol) is displayed, it’s
indicating the ability to:
i. On all sub-menu bars, the “left arrow” is used to navigate “back” to the previous
screen
ii. Data fields that display data and have a “right arrow” at the far right, can be navigated
by clicking anywhere in the data field to access the next screen of data or options
iii. On PEOPLE PAGE > People Views: You must click on the “arrow” to shift the data
displayed up or down by one generation
iv. On PEOPLE PAGE > Sidebar > Family, History and Bookmarks Views: You must click on
the “arrow” on the far right in order to change the People View to the listed Person
V. On PEOPLE PAGE > Sidebar > Info View: On the Parents and Spouses tabs, you can
click anywhere in the “Children” row displaying the “right arrow” at the far right to
display a list of their Children
Vi. On a Person’s Edit Person window: On the Parents and Spouse rows you must click on
the “down arrow” to view the list of People in the family that you can switch to
without leaving the Edit Person window
b. Whenever “number” data fields with a slider input are displayed:
i. Numbers can be set by moving the slider
ii. Or, numbers can be directly entered by clicking on the number data field and typing it
in
c. _Some data fields without “arrows,” when clicked on, display a pre-defined list of choices or

tool icons may appear on the far right that will open relevant tools that can assist you in
determining what should be entered in that data field
If you are new to RootsMagic, in addition to the Online Help, you may find the “Getting Started
with RootsMagic 9” and “What’s new in RootsMagic 10” YouTube videos produced by
RootsMagic helpful in learning the basics and newest features:
a. https://www.youtube.com/watch?v=kjfXNymgNNQO
b. https://www.youtube.com/watch?v=W-3T8rWwwE]
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If the RootsMagic program “freezes” and nothing appears to work for some reason, but other
programs continue to work as normal on your computer, you need to terminate the RootsMagic
program, which can be done as follows:
a. For Window PCs:
i. Press Ctrl, Alt & Delete keys at the same time

ii. Select Task Manager

iii.  Onthe Processes Tab, locate the program and select it

iv. At the bottom right, click on “End Task” to terminate the program

v. Close Task Manger

vi. Restart RootsMagic
b. For Macs:

i. Press Option, Command & Escape at the same time to open Force Quit, or select it
from the menu

ii. Locate the program and select it

iii. Force Quit the program

iv. Close Force Quit

v. Restart RootsMagic
If you move a RootsMagic database file between Mac and Windows computers, the first thing
you should do after opening the file is to run the Tools > Database Tools > Rebuild Indexes
function.
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THE ROOTSMAGIC INTERFACE

https://help.rootsmagic.com/RM9/the-rootsmagic-interface.html

https://help.rootsmagic.com/RM10/the-rootsmagic-interface.html

PEOPLE PAGE

1. Searching from the PEOPLE Page Index and/or People List View:

a.
b.

-~ 0 Qoo

General search format is Surname, Given Name
Anything entered prior to a comma is considered a Surname search phrase and anything
entered after a comma is considered a Given Name search phrase
Partial names can be entered, and names do not have to start with the first letter
Given Names can be searched without entering anything prior to the comma
The search will commence and refine the results as characters are entered in the search box
Wildcard characters can be used in PEOPLE Page Searches:
i. Single character wildcard="_"
ii.  Any number of characters, including none, wildcard = “%"

ili. These wildcard characters also work when searching other lists in RootsMagic, such as
Places, Sources and Fact Types

If you start your surname search with a double quote (“), search results will only include

surnames that start with the letters entered. This special character does not work for given

name searches (letters entered after a comma).

Searches on the Couple List View:

i.  Willinclude Married Surname results.

ii. RM10, You can search for either, or both, Father and Mother names by using an
ampersand “&.” Anything entered before the symbol is applied to the first column
(Father) and anything entered after is applied to the 2nd column (Mother).

If known, you can also enter the RIN (record ID number) for a specific person.

2. Association View:

a.

Associations allow you to define a non-family relationship between 2 people in your
database.
i. Both people must be entered in the database file

ii.  Unlike Facts, Associations cannot be shared with other people; nor can they be copied
or moved

iii. There are 16 built-in Association Types, which cannot be deleted. You cannot edit the
Association name or the names of Role 1 & Role 2 for the built-in Association Types.

iv. RM10, Associations can be transferred to another file via Drag & Drop, if both people

are selected. Otherwise, the Association is dropped, similar to Family/Couple Facts
when the Spouse is not selected
Creating an Association between two people in separate trees within the database file DOES
NOT “connect” the trees together into a single tree.
i. Theyremain treated as separate trees when using the “Count Trees” tool or selecting
“Everyone in a tree” when performing a Drag & Drop, Color Coding, Advanced Person
Searching or defining Group Rules
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The only way to “connect” separate trees is by adding Parent/Child or Spousal family
links to define the family tree relationship

c. Adding an Association:

There are five ways to add an Association to a person:
(1) Click on the +(Add) icon to add a Fact, and then select “Association”
(2) Hover over a person, right click and select “Add Association”
(3) Open the Command Palette and select “Add Association”
(4) From the person’s Edit Person window:
(a) Click on the +(Add) icon to add a Fact, then select “Association”
(b) Hover over the Fact list area, right-click and select “Add New Fact”, then select
“Association”
Then select the Association Type and fill in the rest of the data fields
If you enter data in the Note field, it will be appended to both people’s sentences, if
Notes are included in the report settings

d. Editing an Association:

An existing Association can be edited from either a Person’s open Edit Person Window,

or from the PEOPLE PAGE > Associations View:
(1) From the Edit Person window, just select the Association and edit it. Edits affecting
the Narrative Sentence will be shown in the Sentence window
(2) From the Associations View, you can:
(a) Select and open either, or both, Edit Person windows by clicking on the
corresponding Edit button. Then make edits as described above
(b) Clicking on the Edit Relationship button should be avoided. It opens the Edit
Association window:
i. There is no advantage to using this button. All Association data can be
edited from either person’s Edit Person window.
ii. There is a significant limitation. You cannot see the impact of the edits
reflected in the resulting Narrative Sentence. Plus, you cannot navigate
anywhere else while this window remains open

Association Sentence Templates cannot be customized for individual Associations

f. Toview each Associate’s resulting sentence from their Sentence Template, you must view
the Association from each person’s Edit Person window

g. Association Types:

SEARCH PAGE

Association Types can be created, edited and deleted in a manner similar to Fact Types
by opening the Association Type list.

The decision to modify an existing Association Type vs create a new one follows the
same decision process outlined for Fact Types

Unlike Fact Types, there aren’t individual Association Type settings to select which
outputs to include them in. Instead, the inclusion of all or none is made as part of
defining the output from the database.

1. The columns of information shown in the People and Advanced People search results are the
ones selected to Customize the People List View on the PEOPLE Page
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Person Search View:

a.

Partial names can be entered, and it does not have to start with the first letter

b. Wildcards and the double quote (“) character DO NOT work for name searches
Advanced People Search:

a. Some have reported that RootsMagic is “slow” after performing an Advanced Search as long
as the filtered results are present in the Results area of the SEARCH Page. It is recommended
that once you are finished working with the results, that you click on the Clear Results
button.

b. Wildcards and the double quote (“) character DO NOT work for name searches
The following table contains all the data fields that can be used for Advanced People
Searches based on Criteria and all other functions that utilize the Boolean Logic/Criteria
filter window:

Each Fact in the database Number of children

Any Fact Number of sets of parents
Association RM10, Number of shared facts
Color Coding Number of siblings
Current Age Number of spouses

Date Edited Prefix

FamilySearch ID Record number

Given name(s) Sex

Given or Nickname Source (family)

Living flag Source (general)

Married Surname Suffix

Nickname Surname

Note (family) Surname (Birth or Marr)
Note (general)

d. RMI10, Rules-based Searches were introduced. This RootsMagic blog article provides an
example of how to use it: http://blog.rootsmagic.com/?p=3820

e. Note: Performing searches using “Association” cannot differentiate between the different
Associations Types, only the presence an “Association” in general

f. RM10, A handy application of the Saved Search feature combined with a Rules-Based Group

can be set up as follows:

i. Decide on a common name to use for both the Saved Search and Group. Consider
assigning a simple name that starts with a special character that will sort them to the
top of the Saved Searches and Group listings

ii. From the People Page, create a Rules-Based Group, with one Criteria set to: “Unselect
Everyone In File”

iii. From the Search Page > Advanced People Search View, create a Saved Search with one
Rule: “Group - Select a Group of People” and set it to the Group just created
iv. This can now be used to:
(1) Manually add people to the Group, like people listed on a Census
(2) Use the Saved Searches option found under the Mark/Unmark buttons on the
RootsMagic Explorer window to select the people defined in the associated Group
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(3) Perform the operation that opened the RootsMagic Explorer window to
Mark/Unmark the desired people, like: “Copy Selected Fact”
(4) After completing the operation involving that set of people, “Refreshing” the Group,
which will “Unselect” everyone that had been manually added to the Group.
(5) The Group is then ready for the next set of people to be manually added in support
of the next operation
4. Web Search:

a. The list of people in the database can be searched, similar to the PEOPLE Page Index, using
the format of: Surname, comma, First Name.

b. Partial names can be used too

c. Wildcards and the double quote (“) character work for name searches

5. Find Everywhere:

a. When searching for an item that can be reused multiple times in the database, be aware
that the hyperlink in the search results takes you to the location where the actual data can
be edited and any edits will be reflected everywhere that data is used. To see where the
data is being used, you must view the list of links by clicking on the Used field for the item.

TOOLS PAGE

1. For each tool with a red “Important” warning, you should perform a database Backup prior to
using the tool in case the results are not as expected.
2. FactTools:
a.  When using the “Change Fact Type for Everyone” tool:
i. lrecommend checking all of the Fact Type Property settings, including the Sentence
Template for both the “before” and “after” Fact Types
(1) Date entered in data fields not active in the “new” Fact Type is still in the database,
just not displayed.
(2) Data fields not active in the “old” Fact Type that are active in the “new” Fact Type
will be blank until populated
ii. _Any Property setting difference may require follow-on cleanup work in every affected
Fact and/or the Sentence Template and/or after changing Fact Types, you may want to
create a Group containing everyone with the original Fact Type prior to changing it. This
would become your “To-Do list” of people to review after changing to the new Fact Type
to make sure all fields contain the needed information

SETTINGS PAGE

1. The Settings Views:
a. Program Level settings are set in: Program, Folder, & Display Views
b. File Level settings are set in: General, Preparer, WebHint and LDS Views
2. Program Settings View:
a. Ask for Backup when exiting RootsMagic — YES
Add date to backup — YES
Check for duplicates when adding people — YES
County Check — YES (unless you always use current day locations)
Date entry — USE SYSTEM SETTINGS

® oo
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Folder Settings View:

a. Data Folder — This location should be set prior to using TreeShare with Ancestry or Restoring
a Backup. This will enable RootsMagic to use “relative” paths for media files placed in the
resulting media folders when performing these activities. Otherwise, RootsMagic will store
“discrete” paths for media file links.

b. Backup Folder — Set to its own folder location to keep backup files separate from all other
file types

¢. Media Folder — Starting with RootsMagic 8, media files are linked using “relative” paths from
several locations (despite displaying full path names, including drive letter, to the user;
implying all links are “discrete”).

i. All media files added after a Media Folder location is specified in the Folder Settings
View on the SETTINGS Page will be “relative” to the Media Folder location, if the media
file is located in the folder or a subfolder. Therefore, it is recommended that the Media
Folder specified should be the “top level” folder where most/all media files being
added are located, or in sub-folders. Ideally, the Media Folder location should be
specified prior to linking any media files to information in the RootsMagic database file.

ii. Changing the Media Folder location after already having linked media files will result in
broken links that must be fixed after the change using the “Fix Broken Links” tool
(TOOLS Page).

d. Help Folder — Leave blank to ensure you always view the latest Help information available
online unless you have a unique circumstance where internet access is limited.

General Settings View:

a. Database Color — Recommend selecting a different color for each of your database
files/groups of files, especially if you work with more than 1 open at a time. Remember you
must switch Pages to reflect the newly selected color.

b. Problem Alerts — YES

c. Problem Options — Review to make sure they meet your expectations for Alerts

Display Settings View:

a. Font scaling — Remember to close RootsMagic and re-open to ensure all fonts are set to the
new settings. Also, take note of the setting prior to making a change so that you can reset it
if you decide you don’t like the new setting

Preparer Settings View:

a. Name, Address, Phone and E-Mail are the only entries that will be included in reports when
Preparer Data is selected to be included. Cell, Fax and Website entries are not used in
reports.

WebHint Settings View:

a. Ancestry:

i. For Ancestry Hints to work, you must be logged in and linked to a tree via RootsMagic
Treeshare

ii. The “Clear on Accept” setting controls how TreeShare works, not WebHints. When
selected and the “Only Show Changed People box is selected in the TreeShare window,
after the highlighted Person’s changes are accepted in TreeShare, the Person is
removed from the list of People displayed and the highlighted person is the first person
in the list

Page 10 of 67 8 September 2025



GFO RootsMagic SIG Handout

(1) Itis recommended that this combination of settings only be used when you work
the TreeShare list from top to bottom to avoid having to scroll through the list to
find where you were after each set of changes are accepted.

iii.  Warning: DO NOT select “Disconnect from Ancestry Tree” unless you really want to
permanently sever the Treeshare link between the Ancestry Tree and your database
file. THIS ACTION CANNOT BE UNDONE. If done in error, a recent Backup file from
when Treeshare was still connecting to your tree must be restored, or a new Treeshare
connection must be created with either a new Ancestry Tree or a new RootsMagic file.
(You cannot “re-connect an existing Ancestry Tree to an existing RootsMagic file).

iv. Rather than “Disconnect from Ancestry Tree”, use the “Reset Treeshare” function to
force RootsMagic to rebuild the links between the connected Ancestry Tree and
database file.

b. FamilySearch:

i.  For FamilySearch Hints to work, you must be logged into FamilySearch

ii.  For FamilySearch, hints are provided for people regardless of whether you have
matched them to their corresponding person in the FamilySearch Family Tree

c. FindMyPast:

i. Evaluating and dispositioning FindMyPast Hints is a completely manual process
performed external to RootsMagic. Data from any Confirmed Hints must be manually
entered into RootsMagic.

d. MyHeritage:

i. Evaluating and dispositioning MyHeritage Hints is a completely manual process
performed external to RootsMagic. Data from any Confirmed Hints must be manually
entered into RootsMagic.

8. LDS Settings View:
a. No recommendations
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DATABASES

https://help.rootsmagic.com/RM9/databases.html

https://help.rootsmagic.com/RM10/databases.html

GENERAL FILE INFORMATION :

1.

The database engine used by RootsMagic is SQLite ( www.sqglite.org ). SQLite does not support
multiple users. Therefore, it is important to only have one computer, with one computer
program, accessing the database file at a time

Tech Support recommends not using ANY file syncing/sharing programs on your RootsMagic

database file as it can cause database access errors and, worst case, there is the possibility that

it can corrupt the file, making it unrecoverable. This recommendation is just for the database file
itself and does not apply to media, backups, or any other type of file that RootsMagic
uses/creates. They are aware of situations where people have used file syncing/sharing for
extended periods of time with no issues and then one day their database file becomes
corrupted and is unrecoverable.

When strange things occur that may be the result of a corrupted database file, the following 2

steps should be tried to see if either will fix the issue:

a. Run all of the Database Tools prior to reaching out for help: FILE Page > Tools (also found on
TOOLS Page). Then perform each of the Database Tools (Test Integrity, Rebuild Indexes,
Clean Phantom Records and Compact), the order is not important.

b. If running the database tools does not fix the issue with the database, the next step is to
Drag & Drop the entire database contents into a new, empty, file. Don’t delete the original
file because you may need to reference it to manually migrate data that did not transfer
(see end of this section)

File extensions:

a. ADP & ADP-journal— Interim files created by RootsMagic when the TreeShare window is
open. File is normally deleted by the program when the TreeShare window is closed. It is left
behind when RootsMagic encounters a problem or the process is cancelled while the
TreeShare window is open. These file types can be deleted.

b. docx —Microsoft Word file (PUBLISH Page output format)

DUP & DUP-journal — Interim files created by RootsMagic when identifying duplicate entries
and/or file compare. File is normally deleted by the program when complete. It is left behind
when the program encounters a problem or the process was cancelled. These file types can
be deleted

ged — GEDCOM file (used to transfer data between genealogy sites/software)

e. Ist—RootsMagic list file (text file created when a GEDCOM file is imported into RootsMagic.
It will list any issues encountered during the import process)

f. pdf— Adobe portable document format file (PUBLISH Page output format)

g. rmbackup —v8, v9 or v10 backup file (compressed .zip file)

h. rmgb — RM7 backup file (compressed .zip file)

rmgc — RM7 database file (also RM8 file exported to Dropbox for use by RootsMagic 10S
App)

j. rmtree — RM8, RM9 or RM10 database file
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k. rmtree-journal - Interim journal file created by RootsMagic. File is normally created &
quickly deleted multiple times while performing tasks that require progressing through a lot
of data in the file, such as TreeShare and Building Thumbnails. If left behind due to a task
not running to completion, it may prevent follow-on RootsMagic tasks from running error
free. This file type should be deleted.

|.  rmst — RootsMagic Custom Source Template file (Custom Source templates can be
imported/exported from the Source Template List window)

m. svg — Scalable vector graphic file ((PUBLISH Page output format)

n. txt—Text file (PUBLISH Page output format)

0. xlsx — Miscrosoft Excel file (PUBLISH Page output format)

A database file deleted from within RootsMagic IS NOT placed in the Recycle Bin/Trash Can, it

just permanently disappears.

a. Before deleting, archive (using the Backup function, with media if desired) a copy if you
believe you may want to resurrect/use the file in the future.

CREATING A NEW DATABASE:

2.

Before creating a new RootsMagic file, it is recommended that you first go to the Folder Settings
View on the SETTINGS Page and specify at least the Data and Media folder locations because
these are used by RootsMagic to determine whether “relative” or “discrete” path locations will
be placed in the database to identify link paths to database and media files.

Create New, Empty, File:

a. After creating a new file, do the following:

i. Go tothe SETTINGS Page and review all the File specific settings in the General,
Preparer, WebHints & LDS Views

Create New File by Importing Data or Downloading from an Online Tree:

a. Ifimporting data from a GEDCOM file exported from a RootsMagic file to create a new file,
all limitations and cautions regarding using GEDCOM to exchange RootsMagic data (see end
of this section) apply.

b. Importing data from post-2014 Family Tree Maker (FTM) software files to RootsMagic
cannot be done directly due to FTM'’s proprietary file format. RootsMagic Tech Support
recommends trying all of the following and evaluate which process works best with your
specific set of data:

i.  Sync FTM data to an Ancestry Tree and then download Ancestry Tree data (including
media) to RootsMagic via Treeshare function

ii. Export FTM data to a GEDCOM file and import into RootsMagic

iii. Export FTM data to FTM v2014.0 or earlier and import into RootsMagic (Per Tech
Support, the RM7 import FTM 2014 tool works better than the current RM9 FTM 2014
import tool, this will be fixed in a future update)

iv.  Asyou evaluate the results of the above options, in addition to looking at the file
properties on the HOME Page and Enhanced Property List on the TOOLS Page, you may
want to use the File Compare function to help identify differences between the
imported files.

c. Directimport of Legacy software files to RootsMagic can only be accomplished using the 32-
bit version of RootsMagic installed on a Windows PC (v7 & 8 are only 32-bit, but v9 & v10
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are available in both 32- & 64-bit versions). A direct import will have better results than
using a GEDCOM file due to the improved mapping of data types used in the import tool.
After creating a new file by importing data or downloading from an Online Tree, do the
following
i. Goto HOME Page and review the File Properties to confirm what you expected was
imported
ii. Just like creating a new, empty file, go to the SETTINGS Page and review all the File
specific settings in the General, Preparer, WebHints & LDS Views
iii. Be aware that imported/downloaded data may result in:
(1) New Custom Facts created for Fact Types that do not match existing RootsMagic
Fact Types
(2) Sources and Citations created using the Free Form Template, rather than your
preferred Source Template type.
(3) Place names and Place Details that do not conform to your naming and/or
structure conventions.
iv. Depending on your intended use of this new file, you may need to clean up the
imported/downloaded information to meet your standards/conventions.
Consider “Archiving” a copy of the original file that was imported and a copy of the file after
it was imported for future reference in case you need to determine whether some
erroneous information originated in the original import, or was added later using
RootsMagic. It can also help you figure out if data was “lost” during the import process that
you didn’t notice until later.

OPENING AN EXISTING DATABASE:

The “Recent Files” section lists up to the last 8 files opened

The “Found Files” section only lists files found in the folder and subfolders specified in the
SETTINGS Page, Folders Settings View for the “Data Folder”. The list will contain both RM8, RM9
and RM10 (.rmtree) and RM7 (rmgc) files.

a.

If looking for a “missing file” you are better off using the operating system File
Explorer/Search utilities and wildcard characters to try to locate where the file is located.

WORKING WITH MULTIPLE DATABASES

1.

Up to 4 different files can be open at the same time (only 1 in the free version).

a.

If you want to view information for different parts of your database, other than individual
Person Edit screens; you must make a copy of your database file and assign a different name
to it. Make sure you only make changes in your original file, not the copy. | recommend
giving it a unique Database Color Assignment that reminds you that it’s not your master file
for making changes (SETTINGS Page > General Settings View).

If you have RootsMagic set to open the last file used, when working with multiple databases,
close the database you believe you will want to use next time, last.
The 1% file opened behaves a little different compared to the 2™ to 4" files:

a.

When the 1% file is minimized, all open file windows are minimized

b. Aslong as the 1% file is not minimized, the 2™ to 4™ files can be minimized and they are

placed in the lower left of the desktop
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c. Ifyou close the 1° file before any of the other open files, the behavior of the 1% open file
transfers to the next file opened in the session that remains open

d. Currently, there are a few popup windows that appear centered in the 1% file window, even
if you are working in the 2" to 4 file. Therefore, it is advised to NOT position the 1° file
window so that the center of the window is not in the visible Desktop area. If you do, the
Program appears to “freeze” because you cannot see/click the buttons on the Popup
window, requiring the user to have to terminate the Program execution.

e. Popups | have identified (so far) that center on the 1° file window are:

i. The Spouse selection popup window when creating a Couple Fact (Marriage, Divorce,
etc)

ii. The WebHint list for a Person

DRAGGING AND DROPPING PEOPLE

1. Drag & Drop data transfer limitations:
a. If the Drag & Drop data contains Source Citations based on Custom Source Templates, and
those Custom Source Templates already exist in the destination file, they will be duplicated
b. RMS9, This function is actually an internal GEDCOM export and GEDCOM import of the
selected data between 2 RootsMagic database files.

i. All limitations and cautions regarding using GEDCOM to exchange RootsMagic data
(see end of this section) apply to Drag & Drop too.

ii. Remember: Changes you have made in the past regarding Fact Types to export/not
export into a GEDCOM file should be reviewed to reflect which facts you want
transferred to the destination database file.

iii. Unlike an actual import of a GEDCOM file, you are not given the option to add a Source
Citation to the People and/or Facts “dropped” into the database to document where
they came from.

c. RM10, This function is now a direct database transfer of RootsMagic data, bypassing the
GEDCOM limitations that existed in earlier versions.

i. If retaining the original RINs in a new, empty, file is desired; a GEDCOM file
export/import of the data must be performed with the associated checkbox selected.

ii. RM10, RootsMagic DOES NOT check for duplicate People (RM9 limitations can be
found in GEDCOM Import/Export section). So, after the new data is “dropped” into the
file:

(1) Check for duplicate People:
(a) When duplicate people are found, each person must be Merged and reviewed
for:
(i) Duplicate/similar Facts with different information
(i) Duplicate/similar Source Citations for the same Fact
(2) New Custom Facts are created for Fact Types that do not match existing Fact
Types.

iii. If the Color Coding Set labels from the source file are desired in the destination file, use

the Import Lists function to import them after the Drag & Drop has been completed.
d. RMI10, The latest identified limitations of performing a Drag & Drop operation can be found
here: https://community.rootsmagic.com/t/rm-10-drag-and-drop-findings/11234
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e. All tagged data is transferred, except:
i. Family Facts involving a Spouse that is not also being transferred.
ii. Shared Facts when the Person with the original Fact is not also being transferred.
iii. DNA Page data entered on a Person’s Edit Person window, when the matching person
is not also being transferred

2. Add Parent, Spouse and/or Child links where appropriate between the newly added people and
those already in the database.

3. Can be used to add people to your master database, extract a portion of your master database,
or create a set of data to be “further processed” using GEDCOM export capabilities (privatize
living people, etc).

DATABASE TOOLS

1. Sometimes the Birth & Death dates listed in the Index side area are not automatically updated
when a Person’s corresponding Facts are edited. Running the “Rebuild Indexes” Database Tool
will re-sync the Index dates with the current dates for each event.

2. Sometimes you will notice a completely empty entry for a Person (no RIN displayed, but
otherwise looks like it is a Person record created in the database. These are referred to as
“Phantom Records.” Running the “Clean Phantom Records” Database Tool will remove these
non-existent entries from the database

3. The decision of whether to wait until you notice a discrepancy, do it once a year, a month, a
week or after significant work has been done is left is up to each User to decide

4. When you decide to run a Database Tool, it is recommended that you run all 4 Database Tools
since each tool runs very quickly.

5. The order in which the Database Tools are run does not matter

6. The Database Tools can be accessed from the FILE and the TOOLS Pages

7. If running the Test Integrity/Integrity Check tool doesn’t result in an “OK,” run the database

tools a 2™ time. If the result is still not “OK” the database file has an integrity issue that cannot
be corrected. The only option is to locate and restore a backup file that does pass the Test
Integrity/Integrity Check tool with a result of “OK.”

BACKING UP A DATABASE:

1.

General Info:
a. Backups can be initiated 3 different ways:
i. Closing a file by clicking on the “X” (or Mac equivalent) will cause the Backup popup
window to appear, if this setting has been turned on in the SETTINGS Page, Program
Settings View. Closing a file from the FILE Page will not cause the Backup popup
window to appear regardless of this setting.
ii. Selecting File Page, then Backup
iii. Selecting Tools Page, then Backup database
b. Can be set to include associated media files. However, this consumes a significant amount of
storage space and adds considerable amount of time to perform each RootsMagic Backup
i.  Primarily recommended when you want a complete set of information (database and
linked media files) for the purpose of archiving a copy or perhaps sharing a copy of data
and all linked media files
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ii.  All media files are placed in a single media folder inside the backup file. When restored,
the media files are all restored in a single media folder, any file/folder structure used to
organize media files prior to the backup is lost.

iii.  If broken links exist in the database, the corresponding media files will not be backed
up

iv. Regardless of what is selected, media files not linked to anything in the database WILL
NOT be backed up

Are primarily intended to support “Undo” resurrection of corrupted database files,

accidentally deleted data or files, view archived data to compare with current version of the

database and/or to transfer a database to another computer

RootsMagic Backup files are actually “zip files.” If necessary, you can change the file

extension to “.zip” and then use separate Zip file software to extract the compressed

information

2. When to back up a database file:

a.

Anytime you have entered/changed data you would rather not re-enter should something
unexpected occur to the file (for me, usually once per day of editing when closing the file)
Prior to performing a major change that can affect multiple records in one action (Examples:
cleaning up Place Names, Sources & Citations, Merging Duplicates, Search & Replace, Drag &
Drop people into existing tree, importing GEDCOM data, downloading data from online
sites, etc)

Plus, prior to using any of the following Tools found on the TOOLS Page: Rearrange children
or spouses across the whole database, Delete everyone in a group, Change fact type for
everyone, Remove a fact type from everyone, RM10: Add a fact to everyone in a group, and
DataClean

3. If creating a second (or more) Backup in the same day, add a differentiator (dash number or a, b,
c...) at the end of the filename to make it unique to prevent overwriting earlier Backups, and
also order the files sequentially when sorted by filename

a.

Be aware that if you made a previous backup earlier in the day and have RootsMagic set up
to prompt you for a backup prior to closing the program, RootsMagic asks if you want to
overwrite the existing backup.
i. Ifyourespond “Yes,” your prior backup is overwritten.
ii. If yourespond “No,” the program closes without making a backup.
iii. The only way to avoid this situation is to make the final backup before closing the
program (File > Backup) and changing the filename.

RESTORING A BACKUP

1. General Info:

a.

If you have a RootsMagic 7 Backup file and do not have the corresponding database file, you
can import the Backup file into later versions of RootsMagic by using the Restore function.
When you Restore a Backup file, the restored file will have the filename of the original
database file and cannot be changed prior to restoring it. If you do not want your current
version of the file to be overwritten, you must either restore the file to a different folder,
or move and/or rename your current database file prior to restoring the Backup file.
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c. If your Backup file includes Media files, all linked Media files will be placed in a single folder
created in the location where the file is restored to and any file organization structure you
are using will be lost.

COMPARING DATABASES

1. General Info:

IH

a. The % Match value is the result of comparing “all” information in the database about the
Person, not just what is displayed in the Compare Files window. A match of 98% or more
should be considered the same.

b. The Edit Window can be opened for the selected person in the “primary” file (the open file
from which the File Compare function is initiated). The Edit window cannot be opened for
the person’s record in the other file being used.

c. When selecting Notes, Sources or Media, whichever file you click on becomes the “source”
for any selected items to be moved to the other file.

For Sources, you can only view the full Source Citation from one file at a time

When a person is only present in one file, a Copy To File button appears to allow copying of
all of the person’s information to the other file. However, the copied person will not be
linked to anyone or contain any Family Facts (which depend on linking to other people). Any
required linking or addition of Family Facts must be done as a separate action.

Given the limitations on Editing People, viewing Source Citations and Media files while using the

Compare function, if you expect to be moving a lot of information, or copying people between

files using the Compare function, you may want to consider how you want to make notes on

things that need to be done afterwards. Some options are:

a. Take screen shots

b. Create an Individual List report with all "Information to include” & “Other” options
unchecked and save it to a Word or Excel so that you can search and insert notes, etc and
things to do after exiting the Compare function

IMPORTING LISTS

1.

Up through RM9, only entire Lists can be imported. From RM10 and on, you can select individual

items within a List type to import

When importing a Fact Type list, RootsMagic imports all Fact Types, except the default 64 Fact

Types included in every RootsMagic file.

a. Unlike the default 64 in a new file, these other Fact Types will be imported preserving all the
settings as they are in the source file. This includes whether or not it will be exported to a
GEDCOM file

b. If a Fact Type list is imported into a file that already has data in it, duplicate Fact Types may
be created that should be cleaned up.

Similar to importing a Fact Type List, when importing an Association Type list, RootsMagic will

import all of them, except the 16 built-in Association Types included with every file. The same

caveats for preserving settings and duplicates also apply to Association Types.

Note: If you have an individual Custom Source Template file (*.rmst) that was exported from a
RootsMagic file, these files are imported from the Source Template List window (see Working
with Sources > Source Templates in Online Help).
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4. When importing a list of (Custom) Source Templates from a database file, if they already exist in
the destination file, they will be duplicated.

5. RMDY, Lists of Addresses and Custom Association Types cannot be imported.

6. Importing Color Code Sets will import the labels for each Color Code Set and corresponding
labeled Colors.

IMPORTING/EXPORTING DATA FROM AN EXISTING FILE VIA GEDCOM

1. General information about working with GEDCOM files and data:

a. GEDCOM files (pre-v7.0) are text files and do not contain media images or files. Only the
drive, path and filenames pointing to where your linked media files reside can be included

b. GEDCOM files exported from RootsMagic using the “Extra Details (RM specific)” setting
contain all established TreeShare and/or FamilySearch ID mapping established in the source
database. When imported back into a RootsMagic file (or transferred via Drag & Drop), this
mapping is preserved.

c. RMDY, For reference, here is a technical post discussing what transfers, what is lost and other
issues that occur when transferring data between RootsMagic database files via GEDCOM
and/or Drag & Drop: https://sqlitetoolsforrootsmagic.com/gedcom-dnd-transfer-
losses/?fbclid=IwAR3kychhZa7go7UNM1xohUbsdZ0OSRYMNj6C7XuWQdznYkFHd4pEGa5y8c
n8

d. Forreference, the GEDCOM website (specification can be found here, along with a list of
“Validators”) is: https://www.gedcom.org

e. For Reference, the Family Tree Analyzer tool (Windows only) can be used to look at and
analyze the data in GEDCOM files: https://ftanalyzer.com

2. RMY9, The Drag & Drop function is actually an internal GEDCOM export and GEDCOM import of
the selected data between 2 RootsMagic database files.

a. If you've made changes in the past regarding which Fact Types to not export via GEDCOM,
you may want to review and change the settings back to have them included

b. Unlike an import of an external GEDCOM file, you are not given the option to add a Source
Citation to the People and/or Facts “dropped” into the file.

3. When importing data using a GEDCOM file:
a. Ifyou elect to add a GEDCOM Import Source Citation to added People and/or Facts, the
information you enter will appear in reports in the following form:
i. Source Name: GEDCOM file imported on [DATE]
ii. Footnote and Short Footnote: GEDCOM file submitted by [NAME], [ADDRESS INFO].
Imported on [DATE]
iii. Bibliography: GEDCOM file, [NAME]
iv. The corresponding Citation will be given the same Name as the Source Name and
applied as a “reuse” of the Citation (change 1 Citation and all get changed).

b. After performing a GEDCOM import, check the folder where the destination database file is
located using a File Manager/Explorer program and open the LST file with the same name as
the imported GEDCOM file (using a program that can read text files) and check for any
issues encountered by the import tool
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i. You may need to open the GEDCOM file itself (using a program that can read text files)
to analyze what the data issue is tagged to/located within the imported data set that
the LST file is referring to.

c. When a group of people are brought directly into an existing file via GEDCOM import (or

RM9 Drag & Drop):

i. RootsMagic DOES NOT check for duplicate People. So, after the new data is inserted:
(1) Check for duplicate People
(2) When duplicate people are found, each person must be Merged and reviewed for:
(a) Duplicate/similar Facts with different information
(b) Duplicate/similar Source Citations for the same Fact (note that most imported
Source Citations not added via Drag & Drop will be imported using the Free
Form Source Template)
ii. New Custom Facts are created for Fact Types that do not match existing RootsMagic
Fact Types
iii. Sources and Citations are created using the Free Form Template, rather than your
preferred Source Template type(s).
iv. Place names and Place Details will reflect what was in the GEDCOM file and may not
conform to your naming and/or structure conventions.
v. Add Parent, Spouse and/or Child links where appropriate between the newly added
people and those already in the database.
d. Check for Broken Media Links in imported data (media files are not included in a GEDCOM
file, only drive, path and filename location information).
e. Depending on your intended use, you may need to clean up the imported information to
meet your standards/conventions.
f. Consider whether you want to make a Backup of your database file to archive a snapshot of
what it looked like immediately after your importation of this new set of cleaned up data.
4. When exporting data to a GEDCOM file, do the following first:
a. Ifyouintend on privatizing living people, run an Advanced Search to identify all people
currently identified as living in the Group you intend on Exporting first:

i. Go to SEARCH Page and select Advanced Search View

ii.  Click on the Find button

iii. Select “Living Flag” in the first “Select field” box and “Is True” in the Logic box, and then
click on “OK”

iv. The resulting list is all of the people in your Group that will be privatized. If you see
people that should not be privatized, click on Edit button and make the necessary
corrections

v. Repeat until review is complete

b. The initial default setting for each newly created RootsMagic file is set to export all (default)

Fact Types. Decide whether you want all, or only some Fact Types to be exported. Confirm

export settings for each Fact Type is set as you want, as follows:

i. Select PEOPLE Page, click on 3 dots icon on the People Menu Bar and select Fact Type
List

ii. Note where the “Include GEDCOM: Yes/No” information is located on the Fact Type
screen
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iii.  Scroll through the list of Fact Types to confirm the desired Fact Types you want to
include are set to “Yes” and any Fact Types you do not want to include are set to “No”

Note: If you click on the first Fact Type, you can then scroll through the list by using the
Down Arrow.

iv. To change a setting, click on the EDIT button, check/uncheck the “Include when”
Exporting GEDCOM files” box and click OK

v. Continue to the end of the Fact Type list, then click OK

If exporting a subset of people in your database and you have not created a Group yet, you

may want to create a new Group prior to starting the process to export the GEDCOM file

i. Remember that Couple/Family Facts will only be included with the export if both

people are included in the export

If the data you want to export contains links to media files, check & fix broken media links

(MEDIA Page > 3 dots > Fix broken media links).

If you want the colors assigned for each Color Code Set to be included in the export, you

must ensure that “Extra details (RM specific)” is selected on the GEDCOM Export Options

window. Only the color assignments are included, the Color Code Set and Color labels are

not included in the resulting GEDCOM file.

Now you are ready to export the GEDCOM file

After exporting data to a GEDCOM, if you set some Fact Types to not export, you should

decide whether to reset them to Yes now, or wait until the next time you perform a

GEDCOM Export or Drag & Drop operation to review all their export settings.
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WORKING WITH PEOPLE

https://help.rootsmagic.com/RM9/working-with-people.html

https://help.rootsmagic.com/RM10/working-with-people.html

GENERAL INFORMATION :

1.

After importing data from other sources, you may discover multiple “Primary Name” Facts for a
person, when there should only be one. To reset the Primary Name, create a new, temporary,
name, designate it (temporarily) as the Primary Name. This will reset all other Primary Names to
Alternate Name Facts. Then, select the desired “real” Primary Name and delete the temporary
name created.

Sometimes you will discover a person has an unexpected “Unknown Spouse” listed in the

Descendant View. This is not a record for a person in the database, it is an indication of a

Family/Couple relationship created either by attaching a Child to just 1 parent or a Family Fact

that requires a Couple (like Marriage) and only 1 person is associated with it. There are

situations that can occur where the original cause was corrected, but the Family/Couple with an
unidentified Spouse still exists in the database. These can be corrected by following the steps
listed in the Problem Solving Information section at the end of this document.

a. |If caused by data brought in from another source, when possible, it is best to return to the
source and correct the problem there and then re-import the information

Information on dealing with sensitive family situations such as transgender relatives can be

found here:

a. Yvette Hoitink Blog: https://www.dutchgenealogy.nl/ask-yvette-how-to-record-
transgender-people

b. Stewart Traiman’s website: https://sixgen.org

General information on what and where to enter people’s names can be found here:

a. Tamura Jones blog:
https://www.tamurajones.net/GenealogyNameBasics.xhtml?fbclid=IwAR2WpaawV8JtY51X
DuAwVglLH 30AE5d3WAShW7moC84EICFi9nHIW8-0aHM

Naming convention information for different areas of the world can be found here:

a. Personal Names — Wikipedia: https://en.wikipedia.org/wiki/Personal name

b. Dit Names — Wikipedia: https://en.wikipedia.org/wiki/Dit name#

c. Yvette Hoitink Blog — Dutch Farm Names: https://www.dutchgenealogy.nl/farm-names

d. Scandinavian Family Names - Wikipedia:
https://en.wikipedia.org/wiki/Scandinavian family name etymology

e. Patronymic Names — Wikipedia: https://en.wikipedia.org/wiki/Patronymic# and
FamilySearch: https://www.familysearch.org/en/help/helpcenter/article/how-to-enter-
scandinavian-names-into-family-tree

ADDING PEOPLE

1.

Selecting “Add an Individual” adds a person to the database with no relationship to anyone else.
The other Add options (Spouse, Child & Parents) establish the selected relationship to either a
new, or existing person.
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It is a best practice to add People from a People View that ensures you are establishing the

correct relationship links:

a. When known, add Parents to a Child as a Couple, rather than adding Mother and Father
separately.

i. Caution: If the Couple has already been established, don’t use the individual Add
Father and Mother buttons to add additional Children from the Pedigree View. This will
result in each Child being assigned to its own unique set of Parents (even though they
may be the same 2 People), requiring additional linking/unlinking to properly group all
the Children into the same Family/Couple.

b. Add Children to a Couple from the Family or Descendant View, where you can ensure you
are linking to the correct Couple
People can be added by clicking on the Add a Person (+) icon; in the Pedigree & Family Views,
clicking on the + Add Child, Spouse, Mother, Father boxes; hover over a person and right
clicking; keyboard shortcuts, Command Palette; or from the selected person’s sidebar info view.
The minimum data that must be entered for a new Person to be added to the database is either
their Given or Surname. All other information is optional.
If you know 2 people are siblings, but the parents are unknown, you can connect them by
entering their Father as a new person with the same Surname as a placeholder. Once created,
you can link the siblings to the Father to establish their relationship.
If desired, you can create a person with no name. First create the person with a temporary
name, Save the new Person to create the database record for them. In the Edit Person window,
delete their temporary name. It is highly recommended that you turn on RIN display to aid in
differentiating multiple records with no name entered.

EDITING A PERSON

1.

w

You may want to position the Edit Window so that part of it is outside the area of the main
window so that you can click on it to bring it to the front should it get hidden

You can have up to 3 open Edit windows and still switch between Pages and database files.
To close an Edit Window, click on the x in the corner

You can change the labels used when referring to a Couple’s by their Children (Spouse row)
and/or the Parent’s relationship to their Children (Parents row)

UNLINKING PEOPLE

1.

Unlinking can be performed from any People Page View. However, it is a best practice to
perform unlinking from a View that ensures both you and RootsMagic clearly understand which
relationship link you are about to unlink. The best View to use is the Family View, where
Children are shown with only 1 set of Parents and when a Parent has multiple Spouses, which
one is part of the Family/Couple involved in the unlinking.

When a spouse is unlinked, if the Couple had children linked to them, the children remain linked
to the spouse and their other parent will then be identified as “Unknown Spouse.”

DELETING PEOPLE

1.

In most cases, deleting a person is not the way to correct the problem you are seeing. Prior to
proceeding with a deletion ask yourself:
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a. Should | Manually Merge them instead?
b. Should | leave this person (or Family) floating in my database file, separate from my main
tree to preserve what | know about them?
c. Ifthe answer to the 2 questions is no, then it’s time to delete the person
2. Remember, when you delete a Person:
a. Any links the deleted person (or Family) had with other People in the database are also
deleted. This includes:
i. Links to the Person’s Parents, Spouses and their Children
ii.  Association links to other people in the database
iii.  Shared Facts, shared with other people in the database
iv.  Links to Source Citations, Media, Tasks, etc are deleted
b. Even though links to Source Citations, Media, Tasks, etc are deleted, the actual Source
Citations, Media, Tasks, etc ARE NOT DELETED from the database. They are just used in
fewer places in the database.
i. RM10, After deleting a person, you can review the TOOLS Page > Enhanced Properties
List reported numbers of data types that are “Unused” and decide if you want to select
and delete them as well.

ROOTSMAGIC EXPLORER

1. The RootsMagic Explorer window can be utilized when using the following functions:

a. Creating and editing Groups (in RM9, only Free Form Groups)

b. One of several options to apply Color Coding

¢. RM10, Copying a Fact

d. Selecting People from list to include in some Reports

2. The Mark/Unmark capability allows very creative ways of defining a group of people.

a. Thereis no limit to the number of Mark/Unmark operations you can perform to create the
final list of “selected” people you want to create.

b. However, if you perform multiple Mark/Unmark operations, they cannot be saved to be
repeated again later, after the current use. It is important to record what you do for each
step and the order the steps are performed in order to re-create the same list criteria in the
future.

i. RM10, You can create a rules-based Saved Search, which can record multiple
Select/Unselect (Mark/Unmark) operations and be reproduced again in the future

ii. RM10, You can create a Group that can be refreshed by creating a Rules Group, where
a separate Rule is created for each Mark/Unmark operation, applied in the desired
order.

c. RMDY, If you plan to select people using a single application of the “By Data Fields” option, it
is recommended that you create a Group using the Saved Criteria option instead. This will
allow you to refresh the group membership any time you want in the future.

3. The same data fields available for Advanced Person Search are also available within the

RootsMagic Explorer. Refer to the Search section of this Handout for the table listing all data

fields that can be used.
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GROUPS

1. RMI10, Rules-based Groups was introduced. This RootsMagic blog article provides an example of
how to use it: http://blog.rootsmagic.com/?p=3843

2. Caution: Be careful when naming Groups. RootsMagic will allow you to create 2 different
Groups with the same name

3. When large Groups (>1,000 people) are created using the Search Criteria capability and this
Group is used to filter the list of People shown in the People List or Index, the performance of
RootsMagic is known to slow down its response time to other actions.

4. Using Groups based on Custom Facts is a powerful way to define collections of People for work,
reporting, etc. Custom Facts can be privatized to prevent them from being included in reports,
etc

5. Group membership is not updated as you change information about people, they only get
updated when you decide to refresh each Group

6. When you Merge people that are members of different Groups, only the Group membership of

the Primary Person is retained by RootsMagic. All Group memberships of the person that ends
up being removed is not passed to the surviving person’s record.

COLOR CODING PEOPLE

1.

Consider reserving one of the ten color sets for “temporary” color coding in case you need to
use it to support a specific task you are working on.

Unless you plan to select people using the RootsMagic Explorer window, the color coding will be
based on the person selected prior to opening the Color Coding tool

If you plan on applying the color coding by using Groups, the Groups must be created prior to
opening the Color Coding tool.

A good discussion of RootsMagic color codes and color selection can be found at:
https://sqlitetoolsforrootsmagic.com/colorcoding-

rm8/?fbclid=IwAR2rdgnZeTALalLNvu NN9sFHX y9-giChm23vo3Z krTAwOY3ECUZkV fo

SET RELATIONSHIPS

1. The person you set as the “Root Person” and the person you select to "Show Relationships To”
are two different designations in the database file.

2. Set Relationships does not automatically update relationships when relationship links are
changed or new people are added to the database. You will need to re-run the Set Relationships
function to update the information displayed.

WEBHINTS

General Information:

1.
2.

WebHint Icon Legend: https://help.rootsmagic.com/RM10/webhints.html

Per RootsMagic Tech Support, each company decides when to update their WebHints which
results in sending the latest data about each person in the database and waiting for the
company to provide an updated set of Hints for each person. The number of WebHints for any
person can change at any time due to:

a. Changes made to the Person’s information in the RootsMagic database
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b. The addition of new online records or a new catalog collection applicable to the Person

c. Other users finding and associating record information about the same person to their
family tree

After changing the status of a WebHint, it will not be reflected in the WebHint summary count

window until the WebHint summary window is closed and re-opened. This triggers sending the

updated information back to the company’s hinting system and waiting to receive updated Hints

sent back to RootsMagic (in some cases, this can take several minutes).

Ancestry WebHints:

1.

Ancestry generates Hints for the Ancestry Tree connected to your RootsMagic file and passes
(mirrors) these as WebHInts to RootsMagic via the TreeShare connection.
Ancestry WebHints can only be seen while logged into Ancestry via TreeShare.
Unlike the TreeShare function which provides transfer of information in both directions,
processing WebHints only results in changes to the RootsMagic database. If changes are desired
to be made to the linked Ancestry Tree, TreeShare must be used to select which changes you
want to be made to the connected Ancestry Tree.
Regardless of where you click on the Ancestry Hints row in the WebHints window, the Ancestry
Hints window opens, showing all Hints grouped by type (Records, Other Member Trees &
Photos and Stories) and sorted by status (Undecided, Accepted, Rejected).
Users without a subscription that provides access to Records & Other Member Trees can still
view records that Ancestry makes available for free and all User uploaded Photos and Stories.
Since you cannot tell which records are free from within RootsMagic, you may find it useful to
look at each hint while looking at the detailed field information contained in the Hint compared
to the information entered in your RootsMagic database
a. Inorder to view Photos and Stories files, Users without a subscription must first attach the

file to the person and then open/view the file from the Edit Person Window
Unlike from within Ancestry, Users without a subscription can change the status of WebHints
(Undecided, Accepted or Rejected), and revise the status in the future, if needed. Status changes
made to RootsMagic WebHints are passed back to the connected Ancestry Tree list of Hints.
Processing of Ancestry WebHints involves the following basic steps:
a. View WebHint, when possible
b. View highlighted data differences between Ancestry Hint and RootsMagic person
c. Decide whether sufficient information is available to decide:

i. Hintis applicable and should be Accepted
ii. Hintis not applicable and should be Rejected
iii.  Further information is needed before deciding applicability and should be left as
Undecided

d. When a WebHint is accepted, decide whether to transfer data from hint to RootsMagic

person and/or open Edit RootsMagic Person window to make changes manually
i. Data can be transferred from Ancestry to RootsMagic as a new Fact or replace datain a
current Fact

e. Decide whether to add/modify the Ancestry Source Citation in RootsMagic

Decide whether changes resulting from the WebHint should be “pushed” back to Ancestry
Tree using TreeShare
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FamilySearch WebHints:

FamilySearch WebHints can only be seen while logged into FamilySearch via RootsMagic
FamilySearch provides Record Hints for the FamilySearch Family Tree (FSFT) based on the
information entered for the people in the RootsMagic database and whether or not you have
matched the person to the corresponding person in the FSFT.

Processing these WebHints does not change any information about the Person in the

RootsMagic file, it only affects the Hints for the people in the FSFT and whether or not the

hinted record gets attached to the FSFT person.

a. When the RootsMagic person has been matched to a person in the FSFT, both Pending and
Confirmed Hints are provided (not sure if Rejected hints show in updated status or just
disappear from the WebHints window).

i. Confirmed Hints means they are attached to the FSFT person.
ii. Not all Record Sources attached to a person in the FSFT are presented as WebHints in
RootsMagic.

b. When the RootsMagic person has not been matched to a person in the FSFT, only Pending
Hints are provided.

Evaluation and processing of each WebHint is performed starting at the FamilySearch webpage

linked to the Hint entry in RootsMagic and using the established FamilySearch process for

dispositioning FSFT Hints.

If you determine that an unmatched person’s Hints have helped you identify the matching

person in the FSFT, close the WebHints window and click on the FamilySearch Not Linked icon to

open the FamilySearch Person Tools window (see Online Features-FamilySearch in Online Help)
to match the person.

If after processing Hints in the FSFT you want to add data to the RootsMagic database from the

FSFT, see the Online Features-FamilySearch section in the Online Help.

FindMyPast WebHints:

1.

FindMyPast provides only Record Hints based on the information entered for the people in the
RootsMagic database.
Regardless of where you click on the FindMyPast Hints row in the WebHints window, a browser
window opens showing all the FindMyPast WebHints for the person.
a. Each listed Hint identifies the FindMyPast Record database, with very limited specific
information about what the record contains
b. If you use a free account and log in, you cannot use the Review and Accept functions, but
you can Reject a Hint
i. Insome cases, you may still be able to go into the FindMyPast site and search for the
person and locate the Record Hint and see the complete database index transcription
c. If you have a paid subscription and log in, you can Review, Accept and/or Reject each Hint
i. The ability to change the status of a Hint is done from within FindMyPast and cannot
be done from RootsMagic.
Since there is no data exchange capability between RootsMagic and FindMyPast, any valid Hint
information must be manually entered into the RootsMagic database, regardless of whether you
have a subscription or not.
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4, |ssues using the FindMyPast WebHint webpage linked to from RootsMagic may get resolved by
clearing browser history

MyHeritage WebHints:

1. MyHeritage provides Record and Smart Match (Member Tree) Hints based on the information
entered for the people in the RootsMagic database.

2. Regardless of where you click on the MyHeritage Hints row in the WebHints window, a browser
window opens showing all MyHeritage Hints for the person, grouped by hint type (Records and
Smart Matches).

a. Each listed Hint identifies some, but not necessarily all information contained in the Hint.
b. If you have a free account and log in, you cannot use the Review and Accept functions, but
you can Reject a Hint
i. If the Record dataset containing the Hint is marked as “Free”, you can Review and
Accept the Hint
ii.  Similar to FindMyPast, you may find that you can access and review some Hint Record
datasets by logging into the MyHeritage account, searching for the person, locate the
Record Hint dataset and see the complete database index transcription entry.
c. If you have a paid subscription and log in, you can Review, Accept and/or Reject each Hint.
i. Tracking of Accepted and Rejected Hints is done within your MyHeritage account.
ii.  The ability to change the status of a Hint is done from within MyHeritage and cannot
be done from RootsMagic.

3. MyHeritage can suppress Hints that you have already attached to your MyHeritage family tree
associated with the e-mail account entered in WebHint Settings. If activated, once a Hint is
dispositioned in the MyHeritage account, it will be suppressed and not sent to RootsMagic as a
WebHint. As a result, when filtered, | believe all WebHints listed will be Pending in RootsMagic.

4. Since there is no data exchange capability between RootsMagic and MyHeritage, any valid Hint
information must be manually entered into the RootsMagic database, regardless of whether you
have a subscription or not.

5. lIssues using the MyHeritage WebHint webpage linked to from RootsMagic may get resolved by
clearing browser history

SET LIVING

1. Since this tool can change multiple people at one time, it is recommended that you Backup your
file before proceeding

2. [If sharing your data with online sites, care must be taken to correctly flag all living people to
ensure the online sites properly protect information about living people.

RM10, HEALTH HISTORY

1. General Information:
a. Health data cannot be searched, nor filtered, using any of RootsMagic’s Search tools
b. Health data cannot be exported out of RootsMagic via Ancestry, FamilySearch or GEDCOM
file export
c. Health data can be transferred to another RootsMagic file using Drag & Drop (D&D).
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2. The Health Condition Details data field is limited to 102 characters. However, the Health Note
data field, like all Note fields in RootsMagic, has no character limitation.

3. Health information entered in the Edit Person window Health View is kept separate from all
Facts and other information used to create typical genealogy reports. This allows the separate
tracking of health-related issues that might have hereditary connections without having to be
concerned about inadvertently publicizing personal/private information regarding a person’s
health history.

4. Similar to entering Addresses for living people to create/manage an address book of people,
entering/tracking health history is optional data that has no impact on outputting standard
genealogical information from RootsMagic. But RootsMagic does generate the Health History
specific reports (Family Health History & Health Conditions).

RM10, DNA TESTS

1. General Information:
a. RootsMagic provides 3 different built-in features specific to recording DNA data in the
database file:

“DNA Test” Fact Type:

(1) The default configuration doesn’t use the Description field. Like other Fact Types, it
can be activated and added to the Sentence Template, if desired.

(2) Additional Custom Fact Types can be created

(3) Defining Roles and Sharing the Fact with others may be useful, depending on your
overall approach to adding and managing DNA Test and Match data.
(a) Pros: A single DNA Test Fact assigned to the Tester could be “shared” with all

DNA matches. All relevant match data can be entered in the Supporting Role’s
Note field.

(b) Cons: Shared Facts may not be able to be exported to other sites or programs

(4) Facts can be searched and filtered.

(5) Facts can be exported out of RootsMagic via Ancestry (TreeShare), FamilySearch
and GEDCOM file export

“DNA Match” Association Type:

(1) The default configuration uses the Description field.

(2) Additional Custom Association Types can be created.

(3) Associations cannot be shared, so an Association is required for each DNA Match
being recorded, potentially leading to 100’s or 1,000’s of entries for a Person.

(4) The display of Associations in the Edit Person window can be turned off.
Unfortunately, it will apply to all Associations, not just the DNA Match Association.

(5) Associations can be searched and filtered, but you cannot select specific
Association Types

(6) Associations cannot be exported out of RootsMagic via Ancestry (TreeShare),
FamilySearch or GEDCOM file export

(7) Associations can be transferred to another RootsMagic file using Drag & Drop
(D&D), but only if both people forming the Association are included in the D&D
operation.
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(8) RootsMagic reports (including Custom Reports) cannot be limited to include just
the DNA Match Association. The reports can only be set to include all Associations,
or none

Edit Person Window - DNA Page:

(1) DNA Page data cannot be searched, nor filtered, using any of RootsMagic’s Search
or Group tools

(2) DNA Page data cannot be exported out of RootsMagic via Ancestry (TreeShare),
FamilySearch or GEDCOM file export

(3) DNA Page data can be transferred to another RootsMagic file using Drag & Drop
(D&D), but only if both people forming the DNA Match are included in the D&D
operation.

(4) If you created DNA Match Associations in RM9, as part of the initial database file
conversion process of changing your RM9 file into an RM10 database file, an entry
was created on the DNA Tab for the 2 people identified in the Association and left
the rest of the data fields blank since they didn’t exist as data fields in the
Association.

(a) The DNA Match Association remains unchanged in the Edit Person window list
of Facts for both people

b. User submitted ideas for managing DNA data in RootsMagic:

iv.

Include URLs for the Profile Page at DNA sites using WebTag , Description field, or Note

field (URLs in a Note can be accessed by pressing Crtl-Key and clicking on URL)

(1) When placed in a Note, it can be treated as Private data by enclosing it in curly “{ }”
brackets

(2) Can be placed in a Custom Fact Type that can be enabled/disabled for Narrative
Reports when desired

Use Tasks to tag a DNA Fact or Association and rely on the Task Research Log folders to

track progress in identifying MRCAs (Most Recent Common Ancestor).

Use Sources for each DNA testing company to place DNA match details, notes and

Match Profile URLs in the Citation Details for each Match (which can be linked to both

people)

Use a DNA (), or other colored symbol, Emoiji for visibility purposes.

C. There are no provisions for adding DNA data using bulk/automated methods.

Ancestry controls the TreeShare interface capabilities. This interface does not allow
access to any AncestryDNA data

All DNA match data must be manually entered

Some Tech Savvy users are exploring methods using external 3rd party tools to bulk
load DNA match data into DNA tab on the Edit Person window

Time should be spent developing a consistent “Overall “DNA Strategy” that weighs the Pros

& Cons of each of the above built-in and Custom methods of documenting DNA Test and
Match information that supports your:

i
ii.
iii.
iv.

Desired output reporting capabilities

Desired searching, filtering, grouping and color-coding capabilities
Desired research/analysis capabilities

Desired post-research/analysis capabilities
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2. Edit Person DNA Matches

a.

DNA Match information entered in the Edit Person window DNA Tab is kept separate from
all Facts and other information used to create typical genealogy reports. This allows the
separate tracking of DNA Match-related information without having to be concerned about
inadvertently publicizing personal/private information regarding a person’s DNA Matches.
Similar to Health History data, entering/tracking DNA matches on the DNA tab of the Edit
Person window is optional data that has no impact on outputting standard genealogical
information from RootsMagic, but does allow you to generate the DNA specific reports
(DNA Kinship List & Leeds Method Report).

Depending on your specific situation, entering DNA Shared Match information from multiple
companies into one place may be useful when attempting to view and analyze all
information available (including having software perform Leeds Method analysis rather than
doing it manually or using a spreadsheet) in order to solve, or confirm, family tree
relationships.

If unfamiliar with DNA and/or DNA analysis techniques, | recommend you consider joining
the GFO DNA Q&A Special Interest Group: https://gfo.org/learn/special-interest-
groups/dna-qa.html

DNA Notes entered on the DNA tab of the Edit Person window cannot be included in any of
the RootsMagic DNA reports. DNA Notes are only viewable when viewing a specific Match’s
information on the DNA Tab

i. Reminder: You can view the contents of a Note by hovering over the visible text in the

Note field

Every DNA match entry that does not have a known “Tree Relationship” when initially
created will start as a floating tree containing only one person.

i. RootsMagic does not automatically update the “Tree Relationship” data for DNA

matches after their initial entry.

(1) After adding new links that connect a DNA match to the primary tree, in order to
update the “Tree Relationships” on the DNA Tab, you must select each affected DNA
match and click on the blue “Update” button in the lower right to force RootsMagic
to re-evaluate the DNA match’s “Tree Relationship.”

Consideration should be given to establishing a “system” for being able to discern floating
trees containing DNA match individuals from individuals added to your database for non-
DNA reasons (FAN club, One Name Studies, etc) without having to open the person’s Edit
Person window to review their detailed information.
i. Some possible options include: entering something in Name Suffix field, using the Ref
Number Fact Type, using Emojis, etc
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WORKING WITH FACTS

https://help.rootsmagic.com/RM9/working-with-facts.html

https://help.rootsmagic.com/RM10/working-with-facts.html

THE EDIT PERSON WINDOW

1.

(Not in RM9 Help) You can switch to close relatives of the current person in the Edit window,
without leaving the Edit Window, by clicking on the down arrow for the appropriate Spouse or
Parent to pick the desired Spouse, Child, Parent or Sibling you want to switch to

The Show Relative Events check box shows:

a. Events for the relatives selected on the Options window that occurred during the lifetime of
the person being edited. Note that when a relative’s Marriage Fact is selected, the sentence
displayed in the Sentence area will only include the relative and not their Spouse. To view
the complete sentence that will appear when a Narrative report is generated, you must view
it from the relative’s Edit Person window.

b. If the person being edited does not have a Birth or Christen date then no relative events are
displayed.

When the “Slide-In Workflow” setting is set under Settings > Program Settings, clicking on the

corresponding column location for a Fact causes the information to appear on the left side and

the additional detail information on the right side.

. _Proof:

a. The Proof data field can be found for each Spouse, Parents and Fact entry
b. Each Proof data field has a drop list and can be set to: blank, Proven, Disproven or Disputed
i. When the Proof data field is set to either Disproven or Disputed, the Fact entry in the
Edit Person window timeline list is shown in red with a strike through line across the
text
c. Proof status is not included in any of the RootsMagic reports, it is only an internal visual
reference. If external reporting is desired, an enhanced approach to documenting Proof
needs to be implemented that utilizes data that can be used in report and shared with
others
d. If you decide to use the Proof data field, this FamilySearch Wiki link about the Genealogical
Proof Standard (GPS) may help you decide how you want to define the application of each
of these choices: https://www.familysearch.org/en/wiki/Genealogical Proof Standard

ADDING FACTS

Facts can be added by clicking on the Add Fact (+) icon, or hover over a Fact and right clicking.
When selecting the Fact Type, you can use partial word searches and use the wild cards “_" and
“%”. You can also use the quote (“) to indicate the name must start with the following letters
When entering the:

a. Date: The Calendar and Date Calculator tool icons appear at the far right of the Date data
field

b. Place: The Gazetteer tool and Select Place (in Place List) icons appear at the far right of the
Place data field
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c. Place Detail: The Select Place Detail (in Place Detail List) icon appears at the far right of the
Place Detail field
4. Sometimes Users have trouble deciding which Fact Type to use when they encounter a new type
of record:
a. The following questions and answers may help guide you:
i. Isthe information a Fact or Association relationship that needs to be recorded; oris it
information to be used to “prove” a Fact or Association you have already recorded?

(1) If proving something already entered, then it probably should be treated as a

Source Citation, not a new Fact Type
ii. How often is this situation going to occur in your database?

(1) If rare, consider just using the Miscellaneous Fact Type and customizing the
sentence for each specific use

(2) If many, you probably should create a Custom Fact Type instead

iii. Regardless of how often it occurs in your database, do you envision wanting to use
filter/search criteria for this Fact in the future?

(1) If yes, you should consider creating a Custom Fact, even if used only a few times,
unless you intend on using different text strings in the Description data field of the
Miscellaneous Fact Type that can be searched for

(2) If no, consider using the Miscellaneous Fact, or create a Custom Fact, depending on
how often it will be used in your database file.

b. After reviewing the above questions and answers on how to handle the new record, the
following may help guide you on evaluating your decision prior to implementing your plan:
i.  First, recognize that there isn’t always a single correct answer. In the end, it’s left to
each genealogist to decide, based on their approach and philosophy to documenting
their Family History research, how to proceed
ii. Do you plan to transfer your RootsMagic information with external sites and/or other
software programs?

(1) If yes, to avoid the risk of major re-work in the future, be sure to test how your
decision to proceed transfers to other sites and/or software programs

(2) FYI, despite my full embracement of RootsMagic, to keep my options open in the
future, | still confirm anything | decide to do is exportable via Gedcom and |
understand whether or not it transfers to Ancestry via TreeShare and to
FamilySearch

iii. Do you plan to output Narrative reports?

(1) If yes, be sure to test how your decision to proceed appears in Narrative reports:
(a) Does it appear in the desired section of a person’s report? If not, refine your

solution until it does meet your expectations

(2) Does the Sentence Template produce text that fits with other Fact sentences,
without repeating information found in other Facts?

iv. If you decide to create a Fact and use the record as a Source, the extra effort of doing
both should be “Value Added” towards what you want to accomplish in your
documented research?
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Date Formats

1.

RootsMagic supports four Date Formats. The following image shows how each is displayed when
the SETTINGS > General Settings > Date Format is set to “10 Jan 1959.” When set to a different
option, these formats are presented slightly different:

- |Birth 12da Tmo 1588  Quaker Date Example -
- Birth 15 Feb 1675/6 Double Date Example -
0 Birth Mar Q 1888 Quarter Date Example -
0 |Birth 8 Sep 1888 Standard Date Example -

Double Dates — Additional info about Old & New Style calendars can be found here:
https://en.wikipedia.org/wiki/Old Style and New Style dates
Quarter Dates — This date format is currently not addressed in the Online Help:
a. Quarters can be entered in a variety of recognizable formats which are converted into the
form of: March Quarter, June Quarter, September Quarter & December Quarter
b. In addition to entering the resulting format, various combinations of “first” or “1” and
“quarter”, “gtr” or “q” are recognizable data entry formats
c. Quarter dates are sorted as if they occurred in between the last day of the prior quarter and
the first day of the listed quarter. For example, “March Quarter” would be sorted and placed
after events that occurred on 31 December of the prior year and before 1 January of the
current year
Directional modifiers — RootsMagic will recognize the following entered text and convert it to
the indicated modifier:
a. Enter either “b” or “bef” and RootsMagic will convert it to “before”
b. Enter “untl” and RootsMagic will convert it to “unti
c. Enter either “f” or “fr” or “frm” and RootsMagic will convert it to “from”
d. Enter either “a” or “aft” and RootsMagic will convert it to “after”
e. Entering a space after the modifier is optional, RootsMagic will automatically add one if it is
left out during data entry
Date Ranges - RootsMagic will recognize the following entered text and convert it to the
indicated range:
a. Between/And:
i. Enter “bet” and RootsMagic will recognize it as “Between,” but the word “and” is still
required for it to be a recognizable date format
ii. Aslongasyouinsertthe word “and” or “&"” between the two dates, or partial dates,
RootsMagic will recognize that it is supposed to be in the form of “Between datel and
date2”
b. From/To:
i. Aslongasyou insert the word “to” between the two dates, or partial dates, RootsMagic
will recognize that it is supposed to be in the form of “From datel to date2”
c. You can enter a hyphen and RootsMagic will convert it to an “en” dash, which is the proper
character to use when placed between dates

Ill III
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Date qualifiers - RootsMagic will recognize the following entered text and convert it to the
indicated date qualifier:

Enter “abt” and RootsMagic will convert it to “about”

Enter “est” or “estimate” and RootsMagic will convert it to “estimated”

Enter either “cal” or “Calc” and RootsMagic will convert it to “calculated”

Enter either “c” or “ca” or “cir” or “circ” and RootsMagic will convert it to “circa

There are not standard genealogical definitions for these Date Qualifiers. Therefore, it is
important that each user clearly document somewhere how they are being used in their
database. The same is true for Date Qualitative Modifiers

Both the Calendar and Date Calculator Tools utilize today’s Gregorian calendar. They do not
have the ability to switch or account for the earlier Julian calendar. When working with people
that lived in areas and times were using the Julian calendar, you need account for this by
“translating” the tool result to account for the differences in the calendars. This link can assist in
understanding when the transition took place for specific areas around the world:

https://en.wikipedia.org/wiki/Adoption of the Gregorian calendar

Certain functions can result in truncating or moving extra text to other places, thus the Online
Help recommendation to limit Descriptions to 100 characters or less.

Exporting Descriptions to a GEDCOM file, or using Drag & Drop to move data between
RootsMagic files will result in the Description being truncated when longer than 100
characters.

Using TreeShare to transfer Descriptions to an Ancestry tree will result in the Description
being truncated when longer than 256 characters and the remainder will be placed in a Note

The text entered in the Description data field is inserted into a Sentence Template when a

Narrative Report is created. Therefore, a final period should not be included as part of the data

entry. The sentence punctuation should be included as part of the Sentence Template and not

required in the data entry field

Notes can be added to many different items in the database.

a.

When developing a plan on how to use Notes in support of your research, time should be

spent understanding how and where Notes added to the various items in the database

appear, or don’t appear, when outputting data to one or more of the options (Reports,

Websites, Online Sites and GEDCOM files).

For an individual Person’s profile, Notes can be added to several different areas (Person,

Spouse, Parents, Facts, Shared Facts and Associations). Here are sample reports showing

where each type of Note appears:

i.  Narrative Report Note Placement Sample:
https://gfo.org/file_download/inline/fa3105e6-acc4-424b-881b-33clebc6d55f

ii. Family Group Sheet Not Placement Sample:
https://gfo.org/file_download/inline/783c4e51-1b6d-47c1-bb91-04474e2b5613
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iii. Since Notes are inserted after the sentence generated by a Fact’s Sentence Template, it
is possible to design a Sentence Template that does not end with a period, with the
expectation that the Fact Type will “always” have a Note:

(1) The Note would be entered with the expectation that it’s the end of the resulting
sentence in a Narrative Report
(2) Remember: Footnote/Endnote superscripts will be placed at the end of the
sentence pertion generated by the Sentence Template and prior to the Note text
c. Although not all are called Notes, they can also be added to:
i. For Places, Place Details, Addresses and Repositories; they are called Note
ii. For Sources, they are called Source Text and Source Comment

iii.  For Citations, they are called Research Note and Detail Comment
iv. For Media files, they are called Description
v. _For Tasks, they are called Goal/Details and Results
vi. RMJ10, For Health Conditions, they are called Health Note
vii. _RM10, For DNA Matches, they are called DNA Note
The only formatting of Note text available is Bold, Italics and Underline. You can also insert blank
lines by using the Enter key on the keyboard to insert a carriage return. All other formatting
copy/pasted into the Note field will be lost when the Note is saved to the database
a. Be aware that if you use TreeShare to pass Note data to an Ancestry tree, extra line feeds
and spaces are stripped out by Ancestry
Portions of Note text can be designated as Private by enclosing the text within curly “{}”
brackets
When creating large Notes, you may find using an external Note Editor program (like Windows
Notepad) more convenient that working in the separate RootsMagic Note window.
a. When done, just copy/paste the text into the Note field
b. A key advantage is eliminating the risk of accidentally closing the Note window without
clicking on the Save Note button first, resulting in the loss of all edits made.
c. Plus, you can freely navigate within RootsMagic, if necessary, rather than being forced to

close the Note window first
There is no character limit for Notes
If you hover over the Note field, a popup bubble will show a significant portion of the Note
(~2,000 characters) without having to open up the Note window
There are some Note editing capabilities only available via keyboard shortcuts
The Replace (Ctrl+R) function listed in the RM9 Help does not work. This misleading information
has been removed in the RM10 Help.
If you have inserted URL hyperlinks in a Note field, you can open the hyperlink by pressing the
Ctrl-Key and then clicking on the URL.
If you open a Note in its own, larger, window; you must click on the Save Note button to save
your changes. Closing the window without saving will result in all changes made while in the
window being lost.

RM10, MOVING OR COPYING A FACT

1.

Facts can be Moved, or Copied, by either selecting the Fact and then clicking on the Options

icon; or hovering over the Fact and right-clicking
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2. Facts that have been Shared with other people:
a. The original Fact, shared with others, can be:
i. Moved, and all people it has been shared with are retained
ii. Copied, but all people it has been shared with are not copied
b. The Shared Facts, assigned to people with Supporting Roles cannot be Moved or Copied
using these tools
3. Inorder to create multiple copies of a Fact for the same Person, you must temporarily place a
copy of the Fact with another Person. Then:
a. Ifonly 1 additional copy is desired, use the Move Fact tool to move it to the original Person
b. If multiple copies are desired, use the Copy Fact tool to repeatedly create an additional copy
for original person until only one more copy is needed, and then Move the last one

FACT TYPES

1. There are 64 built-in Fact Types, which cannot be deleted, plus 16 built-in Associations. You
cannot edit the name or abbreviation for the built-in Fact Types and Associations. Here is a link
to a list of the 64 built-in Fact Types and their default information:
https://gfo.org/file_download/inline/8ff7b443-1d40-4db0-84d5-cfce0d279373

2. When data is imported from another source that contains Facts and Events that do not exactly
match the built-in Fact Types, RootsMagic automatically creates a Custom Fact and adds it to
the Fact Type list. As a new Custom Fact Type, with an undefined Sentence Template. After
importing data, it’s always a good practice to review the Fact Type List to see if new Fact Types
were created that are “similar to” existing Fact Types and should be reassigned to the existing
one

3. Asareminder, you can import a Fact Type list from another RootsMagic file. This is covered in
the Databases section. If you import a Fact Type List into a file with existing Custom Fact Types,
RootsMagic does not check for duplicates. You must review the list and clean up the duplicates.
This is best done by:

a. Editing the name of one Fact Type to easily differentiate them

b. Decide which to keep

c. Use the Fact Tool “Change Fact Type For Everyone” to change the Fact Type to be
eliminated to the Fact Type to be kept

4. Deciding when to create a Custom Fact:

a. You want to capture more granularity in your recorded information for searching, filtering,
grouping, color coding, etc
b. You want to exercise more control over Output formats and data content such as:
i.  Narrative Report sentence templates for printed vs website output
ii. Separating Fact information you want included in output reports, from information you
never want included
c. You can’t modify an existing Fact Type to support what you want to record because one or
more of the following apply:
i.  The desired change(s) would negatively impact the pre-existing uses of the Fact Type
ii. The existing Fact Type is one of the “Special Fact Types” and it makes more sense to
address this situation by using both the “Special Fact Type” and a new Custom Fact
Type in combination
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iii. The existing Fact Type can be modified, but you plan on using the modified version in
multiple database files and want to be able to easily add it to new files using the Import
Lists tool
d. You decide the “Miscellaneous” Fact Type is not good enough because one or more of the
following apply:
i.  When viewing the person’s Edit Person window, you want to see something other than
“Misc” in the “Facts” column to convey what the Fact is about
ii. You expect to use it many more times and want to use a common Sentence Template
specific to the Custom Fact
iii. Inthe future, you want to be able to perform searches, apply Color Coding and/or
create Groups based on the Custom Fact
e. If your Custom Fact is only used once in your database, you should consider using the
Miscellaneous Fact Type to avoid growing your Fact Type List unnecessarily
5. Creating a new Custom Fact Type:
a. The Fact Type List can be accessed in the following ways:
i. People Page > More Options > Fact Type List
ii. Edit Person window > Add Fact (+icon)
iii. Edit Person window > Hover over area on the left > right-click > select Add New Fact
iv. TOOLS Page > “Add or Modify Fact Types”
v. Command Palette > “Fac”
b. When naming a new Fact Type, thought should be given to where it will show up in the Fact
Type List and how many letters must be entered in the search box to find and select it
c. Caution: RootsMagic does not prevent you from re-using an existing Fact Type name
resulting in 2 different Fact Types with the same name
d. When creating a Fact Type, the Date, Place and Description data fields are optional choices
that determine whether these data fields are displayed in RootsMagic when viewing Facts
based on the selected Fact Type
e. If aSentence Template is not entered, RootsMagic automatically creates one in the form of:
i.  “[NEED TO DEFINE SENTENCE: FACTTYPENAME]”
ii. Fact Types missing a Sentence Template can be identified using the TOOLS >
ENHANCED PROPERTIES LIST tool
f. New Fact Types are only created in the currently open database file. If you have other
database files you want to use it in, you must use the FILE > IMPORT DATA > IMPORT LISTS
function to add it to your other file(s)
6. If you edit a built-in Fact Type and you want to make the same changes in another file, because
the Import Lists feature doesn’t work on built-in Fact Types, you will need to either:
a. Manually make the same changes in the other files
b. Or, if the changes weren’t made to one of the “special” Fact Types listed below, create a
Custom Fact Type with the desired settings and use the TOOLS > Fact Tools > “Change Fact
Type For Everyone” tool to replace the use of the built-in Fact Type with the new one
7. If you delete a Fact Type that has Facts based on it, all of the Facts will be deleted too, if you
acknowledge the warning. Any links to Sources, Media and/or Tasks linked to the deleted Facts
will also be deleted from the database.
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a. However, any Sources, Media and/or Tasks that are no longer linked to other information
will still remain in the database file and can be found on their respective PAGES
8. Wildcards (__and %) and the double quote (“) character work for Fact Type searches too

9. Several of the built-in Fact Types have “special” uses in RootsMagic. They are:
a. Birth, Christen, Marriage, Death & Burial Fact Types are used by RootsMagic:

In standard reports that include Birth, Marriage and Death information

To calculate age - requires a date entered in a person’s Birth or Christen Fact

(1) Note: Some Users that have people with no Birth or Christen Fact, but have a
Baptism Fact for a Person have decided to use the Christen Fact instead of a
Baptism Fact and modify the Principal Sentence Template for the Christen Fact
Type (or customize individual Facts) to state that the person was Baptized

To automatically uncheck a person’s “Living” checkbox — requires a person to have a

Death or Burial Fact or, a Birth or Christen Fact with a date that is at least 105 years ago

To flag Problem Alerts (red dot with exclamation point) and include them in the

Problem List report

If you enter more than one of these Fact Types for a Person, RootsMagic may not

properly perform the actions listed above. To avoid this, one of the Fact entries should

be identified as the “Primary” Fact by checking the checkbox for that Fact.

b. Primary Name:

Each person can only have 1 Primary Name Fact and it is automatically created when a
person is added to the database

It is not available to choose from the Fact Type List

All the information about a person’s name that is used by RootsMagic is recorded here
There is no Sentence Template for this Fact Type. The Primary Name Fact information
can be used in all Fact Sentence Templates defined for all other Fact Types

c. Alternate Name:

i
ii.
iii.
iv.
V.

The data fields are the same as those for the Primary Name Fact Type

You can designate that an Alternate Name Fact become the new Primary Name Fact for
a person. This makes the previous Primary Name Fact an Alternate Name Fact

Cannot be shared with other people

Cannot be used as a “Criteria” for use in Searches, Groups or Color Coding

Cannot be included in Custom Reports

d. Association:

iii.
iv.

Although Association appears in the Fact Type List, Associations are different. Facts
tend to be event-based information recorded about a person

Associations tend to be used to record, nonevent-based, non-family relationships
between 2 people in the database

Cannot be shared with additional people

Cannot be copied or moved like Facts.

e. Reference No (Ref #):

By default, this Fact Type only uses the Description and Sort Date fields

Since the RIN is not guaranteed to remain permanently assigned to a specific person,
The intended use of Ref # is to allow the assignment of a preferred/permanent
numbering scheme to people in the database
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The Ref # can be displayed appended to the end of a person’s name within RootsMagic
similar to the RIN or FSID by going to SETTINGS > GENERAL SETTINGS and setting
“Number to Display” to “REFN”

iv. Some other possible uses are:

(1) This RootsMagic blog article provides an example of how this Special Fact Type can
be used to visually enhance the information about people in a database:
http://blog.rootsmagic.com/?p=3877

(2) The assignment and display of Ahnentafel numbers

(3) Differentiate unlinked people resulting from documentary vs DNA research

(4) A place to assign Emojis

(5) Unlike RIN and FSID, Ref # can be transferred to an Ancestry tree as a Fact using
TreeShare

f. Adoption:

In addition to the Date and Place data fields, this Fact Type also has a data field called
Parents. Clicking on the Parents data field presents a list of all the Parent Couples
already identified for the Person that the Fact is being added to.

The identified Parents are not part of the default Sentence Template and there isn’t a
way to add them since the Sentence Template Language does not define a variable for
Parents.

Although disabled in the default configuration, if desired, the User can enable the
Description data field by editing the Fact Type, allowing the [Description} Sentence
Template Language variable to be added to the Sentence Template.

g. LDS specific Fact Types: Used to interface with LDS specific information at FamilySearch
10. Sample uses of Custom Fact Types:
a. To manage status (work completion, level of documented Facts, group membership) of
people in the database:

An example would be to track each person’s research status based on Yvette Hoitink’s
Level-Up Challenge: https://www.dutchgenealogy.nl/six-levels-ancestral-profiles or any

other defined set of levels and criteria for each level

b. You want to modify the default Sentence Template of a built-in Fact Type (that isn’t one of
the “special Fact Types” listed in this Handout) and be able to replicate the changes in
additional database files using the IMPORT LIST function

c. You want more granularity for a Fact Type to: search, filter, group, color code, etc,

An example would be creating separate “Census 1900” & “Census 1910” Fact Types
instead of the built-in “Census” Fact Type so that filtering can be performed for each
different Census Fact Type

d. Once created, these Custom Fact Types can be added as additional columns in the People

List, used to create Color Coding, etc

An example showing a User’s Census completion status grid in the People List View is

shared in this RootsMagic Community post: https://community.rootsmagic.com/t/my-
people-list-view-grid
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In order to Share Facts, Supporting Roles must be created for the affected Fact Types. Refer to

the SHARING FACTS section for information on the tradeoffs to consider between sharing and

replicating Facts with other people. Although it requires more time and effort to implement, a

third option is to do both:

a. Use Shared Facts to enhance Narrative Reports, including relocating sentences for

Family/Couple Facts to the Individual/Person section of the Narrative Report Fact timeline

b. AND, create copies of the Fact for the same people to ensure no data gets lost in data

exports.
c. To implement this option and avoid duplication in Narrative Reports:

A Supporting Role should be created that will be “shared” with the Principal. This Role

will contain the Sentence Template to be used for the “Supporting” Principal Role
The Fact’s Principal Role Sentence Template should be deleted thus preventing a

sentence from being generated for the Role when a Narrative Report is generated
The end result is everyone involved having 2 Facts for the same event.

(1) One as a Supporting Role assigned from the original Fact entered for the primary
person, including the primary person.

(2) The second Fact is a copy of the primary person’s Fact, Because the Principal Role
does not have a Sentence Template for the Principal Role, all sentences will be
generated using the Supporting Role Sentence Templates

A Custom Fact Type must be created and saved before Supporting Roles can be added

If Supporting Roles exist for a Fact, they do not have to be used

You can assign a person not in your database to a Shared Fact Supporting Role

When Sharing a Fact, the list of Supporting Roles to choose from is listed in the order they were

created, not alphabetically.

a. When creating many Supporting Roles for a Fact Type, advanced planning of the desired
order to list them is recommended

b. In an existing list, if you want to change which Supporting Role is listed first, you must:

Create new Supporting Roles for each Role currently listed above the one you want to

be first

Switching all affected people to the newly defined Role(s). You can do this by:

(1) RM9, Make a Group of all people that have the Fact Type containing the affected
Supporting Role(s)

(2) RM10, Make a Group of all people in the database that have the “Number of
Shared Facts” >0

Filter the Index List to only show people in the Group you just created

Open each Person’s Edit Person window and check to see if the Fact Type being

modified has been Shared, and if so, whether the Supporting Role that is being

changed was Shared with them

(1) If it was Shared, change the assigned Role to the newly created one

(2) If a Supporting Role Note was entered previously, it remains after changing the
Role
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v. Once every Person has been checked, then you can delete the “old” Supporting Roles
from the Fact Type which should result in the desired Supporting Role being at the top
of the list

vi. NOTE: To avoid doing the above, as soon as you decide to Share Facts:

(1) You should spend time thinking through what your desired order of Supporting
Roles to choose from should be and create the Supporting Roles in that order

(2) If you don’t want the built-in Supporting Role (usually “Witness”) to be the default
at the top, delete it and recreate it when desired

6. When crafting Sentence Templates for Supporting Roles, remember:

a.

b.
C.
d

[Person] always refers to the Principal Person, even when working with a Family Fact
[ThisPerson] refers to the person assigned to a Shared Supporting Role
[OtherPersons] is everyone that is assigned to any of the Shared Supporting Roles
[Role] where “Role” is the Supporting “RoleName” is:

i. Everyone assigned to the specified Shared Role when used in the Principal template

ii. Everyone assigned to the specified Shared Role, except the Person the Fact is Shared

with. To include them, [ThisPerson] must also be included.

[ThisPerson:Role] results in the Role Name being inserted in the sentence rather than
ThisPerson’s name

[Field#] allows you to specify specific people’s names that have a Shared Role when more
than one person has been assigned the same Supporting Role. Caution must be exercised
when using this if you are trying to single out specific people in your template since the # is
based on the order people are assigned the Supporting Role
Only people assigned Supporting Roles that are mentioned in the Principal Sentence
Templates are listed in the Narrative Report Name Index. This can be an import way to
include important people that aren’t otherwise related to the family line the report is being
generated for

7. When you add a new Role to a Fact Type, you should stop and ask yourself:

a.

Do you need to modify the Sentence Template for the Principal Role, or any other
Supporting Role Sentence Templates for this Fact Type to include the people that get
assigned to this new Role?

Are there people in your database that you want to go back and decide whether this new
Shared Fact Supporting Role is applicable to their Fact. If yes, you may want to make a
Group of everyone currently in your database with this Fact Type to use as a “T0 Do” list of
people to check now, or in the future. If you choose to do it later, you may want to create a
Task describing what needs to be done to refresh your memory when you are ready to
proceed

8. If you modify the name of a Supporting Role for a Fact Type, remember to review the Sentence

Templates for the Principal and all other Supporting Roles to see if you used the Role Name in

any of the templates. If it was used, they must be edited to match the revised Role Name

CUSTOMIZING SENTENCES

1. If you use the “Customize Sentence” function on a person’s Edit Person window for a specific
Fact, be aware that currently there is no way in RootMagic to locate them in the future other
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than opening each Fact assigned the Fact Type in question and comparing its Fact Sentence with
the default Fact Type Sentence Template

2. If you delete the Fact’s Sentence Template, you will get the same result as if you had clicked on
the “Reset To Default” button. The default Fact Type Sentence Template will be inserted

3. Things to consider before customizing a Fact Type Sentence Template:

a. Isthe change you're considering just a one-off situation, or only applicable to a few people?

If yes:
i. Just customize that specific Fact Sentence Template
ii. Copy/paste the revised sentence format to the few other people it applies to
iii. If you want to locate these customized Fact sentences in the future, consider making a
list of who and which Facts you modified in a separate log file, or tag each modified
Fact with a common Task

b. Is this change something you’ll want to apply to several people’s Facts? If yes:

i. Consider the possibility of modifying the Fact Type Sentence Template using the
Sentence Template Language

ii.  Or, create a similar, but different, Custom Fact Type allowing you to select one or the
other depending on which Sentence Template is more appropriate for the Fact you are
entering. As long as it’s not one of the “Special” Fact Types.

c. If the customization involves people the Fact is being shared with, you should ask yourself
whether the changes should appear in the Sentence Template for the Principal, a particular
Role, both or maybe you need to create a new Supporting Role for this unique situation

d. When customizing a Sentence Template for a Fact that has been Shared with a Person
assigned a Supporting Role, be aware that the resulting sentence in the lower portion of the
window will only include [Person], if used. [Date], [Desc], [PlaceDetails] and [Place] from the
Principal’s Fact will not be shown. To see the complete resulting sentence, you must click OK
and view it in the “Sentence” area on the Edit Person window.

SENTENCE TEMPLATE LANGUAGE

1. The Online Help for this topic covers all the Template Language Data Field Names, Field Options,
Formatting Codes and Switches that can be used along with some examples of their use:
https://help.rootsmagic.com/RM10/sentence-template-language.html
a. The Online Help incorrectly states that the Private Switch can be used for Fact Sentence

Templates. Actually, it can only be used with Source Templates.

2. Blank lines can be inserted in a Sentence Template by adding Carriage Returns (pressing the
Enter key) where blank lines are desired

3. Reminder: Modified Sentence Templates for built-in Fact Types must be manually transferred to
other RootsMagic database files you want to use them in. Neither the Drag & Drop, nor
Importing Fact Type List functions will modify the sentence templates of built-in Fact Types in
the destination file.

4. My recommended 9-step approach to crafting a Sentence Template:

a. When you are planning to create, or modify multiple Role templates for a Fact Type, you
may find it easier to focus on developing one at a time, starting with the Principal Role and
then moving to any Supporting Roles desired. This will allow you to focus on a single goal
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and leverage any common elements in subsequent iterations to develop the other
templates

Examples using this 9-step approach can be accessed here:
https://gfo.org/file_download/inline/cd4aa506-b997-444a-907d-9fcef436cefb

Step 1: Draft a sample of how you want the resulting sentence to read

Step 2: Replace the pieces of the sentence where the specific information will come from
one of the Fact Type Data Fields

Step 3: Confirm the needed Optional Data Fields are active for this Fact Type

Step 4: Determine if there are additional people and/or Supporting Role names that need to
be included in the sentence.
i. If the only other person is the Principal’s Spouse, then the Custom Fact Type
should be created as a Family Fact Type. Or, create as an Individual Fact Type,
with a Supporting Role to share with the Spouse.
ii. If other people are to be included, their Supporting Roles must be created so
they can be assigned to these people and included in the sentence
1. Reminder: There are a variety of Field Names when referring to people
other than the Principal Person and sometimes they are different when
referring to them in the Principal sentence vs a Supporting Role sentence.
They are listed in the Online Help

2. Note: When generating a Narrative Report that includes the Principal,
people assigned Supporting Roles and included in the Principal Sentence
Template will be included in the Narrative Report Index, even if the report
does not include the Supporting Role Person

iii. For each Supporting Role created, this 9-step process should be repeated to
craft each corresponding Supporting Role Sentence Template

Step 5: Evaluate the default verbiage that RootsMagic automatically adds to determine
whether some Field Options need to be specified to get the desired result.

Step 6: Determine whether, and where, conditional brackets are needed to address
situations when one or more of the specified Data Fields are blank

Step 7: Decide whether any Switches are needed due to different verbiage needed
depending on a Value, Gender, Number of People or whether the person is Living or not.
i. Remember: Switches can be “nested” inside of other switches allowing you to
create very powerful and flexible sentence templates, when needed

Step 8: Decide whether any text formatting is desired (Bold, Italics, All Caps, etc)

Step 9: Trial & error testing:
i. Remember that “trial & error” is part of the process of crafting the Sentence
Template that you want, as long as what you want isn’t more sophisticated
than what the Sentence Template Language supports
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ii.  Since RootsMagic processes the template left to right, when issues are
encountered, you should also work left to right through the template to
identify & correct them.

c. Ifthere are additional Sentence Templates to develop for the Fact Type, repeat the 9-step
process for each one

d. Once all templates have been developed and tested, they need to be inserted into the Fact
Type as the default Sentence Templates for their respective Roles

e. Lastly, ensure that the People’s Facts that were being used for template development &
testing by Customizing their specific Sentences have their Customized Sentence Templates
“Reset to Default” by either clicking on the button, or deleting the entire contents of the
Sentence Template area

SHARING FACTS

1. The quandary (Pros & Cons) between using/not using Shared Facts by assigning Supporting

Roles:

a. https://sqlitetoolsforrootsmagic.com/facts-split-shared-to-
individual/?fbclid=IwAR30EgpKaHAB 5ulLkme3vgB6F-
NLxjxUgaCgxwd0O0g50qL7xq5Hr7HDNZ9I

b. RM10, The new Copy Fact tool eliminated the tradeoff of using Shared Facts to save data
entry time & effort vs re-entering the same Fact for multiple people as a consideration of
whether or not to use Shared Facts

c. Use Shared Facts to create more complex narratives about people’s lives and relationships
with others. But don’t plan on:

i.  Exporting Shared Fact information to other sites and software, many of these other
locations cannot extract the Shared Fact information contained in a RootsMagic
generated GEDCOM file

ii. Neither Ancestry (via TreeShare) nor FamilySearch accept Shared Facts from
RootsMagic

ili. Tagged Media files and Tasks being shared with people assigned Supporting Roles

iv. Being able to manage them like Facts, since you cannot search for them or create
reports that include them other than generating Narrative reports and exporting them
to a My RootsMagic Website

d. Don’t use Shared Facts when wanting to:

i.  Preserve maximum flexibility in exporting data to other sites and software

ii. Manage them the same as all other Facts

e. Tech Savvy users can use external 3rd party tools to manipulate either a RootsMagic
database file or GEDCOM export file to try and convert Shared Facts to Individual Facts

2. When viewing the list of Facts in a Person’s Edit Person window, the Shared Facts column:

a. A blank entry indicates the Fact cannot be shared because it is “special”

b. A “-“indicates the Fact can be shared, but has not been shared with anyone yet

c. A number indicates the Fact has been shared with the indicated number of people

3. When viewing a Shared Fact in a Person’s Edit Person window:

a. The information displayed in the Edit Person window’s list of Facts is the information that

applies to the Principal Person, not the Person assigned the Supporting Role

Page 45 of 67 8 September 2025


https://sqlitetoolsforrootsmagic.com/facts-split-shared-to-individual/?fbclid=IwAR30EqpKaHAB_5uLkme3vqB6F-NLxjxUqaCgxwdO0g5OqL7xq5Hr7HDNZ9I
https://sqlitetoolsforrootsmagic.com/facts-split-shared-to-individual/?fbclid=IwAR30EqpKaHAB_5uLkme3vqB6F-NLxjxUqaCgxwdO0g5OqL7xq5Hr7HDNZ9I
https://sqlitetoolsforrootsmagic.com/facts-split-shared-to-individual/?fbclid=IwAR30EqpKaHAB_5uLkme3vqB6F-NLxjxUqaCgxwdO0g5OqL7xq5Hr7HDNZ9I

GFO RootsMagic SIG Handout

i. If you edit any of this data, you will be changing the information for the Principal
Person, not the Person assigned the Supporting Role

b. To view the data applicable to a Person assigned a Supporting Role (Person, assigned Role

and their Note), you must view the Shared With list and select a person
4. When Sharing a Fact and assigning the same Supporting Role to more than one Person, when
the names of people with this Supporting Role are listed, they are in the order the Supporting

Role was assigned to each Person

a. When a Fact is Shared with multiple people at the same time, the order in which they will be
listed is unpredictable

5. When assigning a Supporting Role to a person not in your database, remember that:

a. You can only enter a Given name and Surname. Also, if you have SETTINGS > GENERAL
SETTINGS > “Surname Uppercase” checkbox checked, RootsMagic DOES NOT capitalize the
Surnames of these people that are not in the database

b. If you enter a Role Note, it will never appear in a report since these people aren’t in the
database, there won’t be a Narrative report entry for them, which would be the only
location where the Note would be used

6. If you want to switch an assigned Supporting Role from a person in the database to someone
not in the database or vice versa, you cannot do it by editing the existing assignment. You must
create a new Shared Fact entry
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WORKING WITH PLACES

https://help.rootsmagic.com/RM9/working-with-places.html

https://help.rootsmagic.com/RM10/working-with-places.html

GENERAL INFORMATION

1. Entering Place data:

a.

Place data is entered from smallest to largest geopolitical divisions. Even if you have elected

to display Reverse Place Names
i. RootsMagic does not enforce a maximum number of levels that can be entered
ii.  Specific data, like street address and/or building/cemetery name is typically entered as
a Place Detail. Some users decide to enter it as the smallest division of the Place
iii. Place Detail entries are specific to a Place entry. If the same Place Detail exists in more

than one Place, it must be entered, and managed, separately for each Place
As you type, RootsMagic shows you up to 5 entries already in your database that match

what has been typed so far. Selecting an entry in the displayed list:
i. Eliminates the need to type the full Place name
ii. _Avoids the introduction of typos, which would result in the creation of a new Place
entry in the database containing the typo, requiring cleanup later
Generally accepted practices regarding Places are:

i. Enter the historical location where each event occurred. Some users elect to enter
what they believe is the current day location instead.
ii. Avoid the use of abbreviations in Place names, spell everything out
iii. Avoid the use of place division descriptors, like “county”

Additional data entry topics to consider:

i. Whether to enter foreign Place names in English, or the native language
ii. What are the proper geopolitical divisions in each foreign country
The above are not “rules,” many genealogists elect to deviate from the above generally

accepted practices.
i. Being as consistent as possible within a database file is the most important decision
ii. Regardless of how consistent you try to follow whatever “rules” you establish for your
research, you most likely will encounter exceptions that must be recorded (for
example, a city in a state that is not part of a county and the same state has a county of
the same name as the city...)

2. Management of Place data should be done from the PLACES PAGE, not an individual Person’s

Edit Person window

a.

When an existing Place or Place Detail entry for a Fact is modified from the Edit Person

window, the existing data is not modified. Instead, a new entry is created and stored in the
database
When an existing Place or Place Detail entry is modified from the PLACES PAGE, the change

will be reflected in every Fact that uses it

3. You can identify People that have Facts and Associations that don’t have a Place entered by:

a.

SEARCH PAGE > Advanced Search > Find (or create a refreshable Group)

Search Rules > Add Criteria

“Any Fact” “Place” “Is Blank”

The result will be a list of People that have at least one Fact missing a Place

ol o

Each Person’s Edit Person window must be opened to review their list of Facts
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4. For those using TreeShare, be aware that TreeShare does not flag differences in Place entries as
a change needing to be shared with the Ancestry Tree. Edits to Place names must be made
directly in the Ancestry Tree

5. Forthe Tech Savvy familiar with SQLite, some of the topics and scripts regarding Places found
here may be of interest: https://sqlitetoolsforrootsmagic.com/category/places

6. For those interested in Visualizing Place Data using 3™ Party tools, This RootsMagic Community
post ( https://community.rootsmagic.com/t/other-visualisations ) discusses the use of Google
Earth Pro (_https://www.google.com/earth/about/versions ) and RootsMapper (
https://rootsmapper.com )

PLACE LIST

1. The number shown in the “Details” column indicates the number of unique Place Details that
exist for the Place. The number shown in the “Used” field indicates how many links to the Place
exist in the database.

2. When viewing a selected Place, if RootsMagic confidently recognizes it, the small map on the
right will display a marker and the Place name, even if it’s not currently Geocoded (lat/long
entered). If the map remains blank, it means RootMagic cannot confidently recognize the
location

3. The “Standard” data field:

a. s typically used to identify the current day Place name. If used, the Geocoding tool will fill it
in
b. Itis not used for anything else:
i. You cannot use it for Searches, Groups or Color Coding
ii. Youcan'tinclude it in any reports
iii. There isn’t a Sentence Template Language variable for it either
4. The “Abbrev” data field:
a. Is used to specify what to use as the “shortened Place Name” when Sentence Templates
using “[Place:Short]” are encountered while generating a Narrative report
b. Application of this Field Option must be carefully planned out since, if applied in a Fact
Type’s Sentence Template:
i. The full place name will only be included for the associated Fact sentence if each
specific Fact sentence is individually customized
ii. Or, youonly use the “:Short” Field Option in specific, customized, Fact Sentences;
rather than including it in the Fact Type Sentence Template
c. _The Tech Savvy developed an external script using 3™ party tools that can modify a Person’s
Fact Sentences to include the full Place name at first occurrence and the Abbrev name for
subsequent uses: ii. https://sqlitetoolsforrootsmagic.com/places-first-name-exploit-for-
improved-narratives/?fbclid=IwAR1fD901gAQmM2gFQYcTR7hhX-
koA59 wTwpsWVmlQtmleumZcO2UwhgBIN8
5. The “Note” data field:

a. The information entered as a Place Note is displayed when the user opens the “Select Place”
(in Place List) icons and highlights a Place hame

b. This could be use as a way to identify the date range a particular Place name existed when
dealing with a location that had different historical names, compared to the present day and
avoid future reminders from the CountyCheck tool
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c. _This could even be expanded to include historical Place names before and after the period
applicable to the currently selected Place name
6. Media, Tasks and WebTags attached to a Place cannot be viewed from a Person’s Edit Person
window. You must switch to the PLACES PAGE and select the Place
7. A new Place can be entered on the PLACES PAGE by either:
a. Clicking on the Add (+) icon
b. Or, hovering over the Places list area, right-click and select “Add New Place”
8. An existing Place can be deleted from the PLACES PAGE by:
a. Unless you already know, it’s always a good idea to check what the Place is currently linked
to by clicking on the “Used” field, if it not “0 (unused)”
Select the Place, then click on the Delete (trash can) icon
c. Or, Select the Place, then click on the “More Options (3 dots)” icon and then select “Delete
Selected Place”
d. Or, Hover over the Place, right-click and select “Delete Selected Place”

PLACE DETAILS LIST

1. When viewing a selected Place Detail, if RootsMagic confidently recognizes the Place, the small
map on the right will display a marker along with the Place Detail and Place name. Be aware that
what is actually being displayed is based on just recognizing the Place. If the map remains blank,
it means RootMagic cannot confidently recognize the Place associated with the Place Detail

2. The following topics described above in the Place List section also apply to Place Details:
a. Standard, Abbrev and Note data fields
b. Media, Tasks and WebTags

MERGING PLACES

1. When you discover multiple entries in the Place List that are actually the same place, like most
data in RootsMagic, you shouldn’t delete & re-enter the data, you should “Merge” the data
2. Before performing a merge, consider the following:
a. Depending on the extent of the merging to be done, consider making a backup before
proceeding with the merge process
b. Only the “surviving” Place name, Standard and Abbrev data fields survive the merge. The
data entered in these data fields in the other selected Places will be gone
c. Ifthe Lat/Long data fields for the “Surviving” Place:
i. Contain data, any Lat/Long data entered in the other selected Places will be gone.
ii. Are blank, and there is Lat/Long data entered for the Place selected to be merged, the
Lat/Long data is transferred to the “Surviving” Place.
d. When Place Notes exist:
i. They are all appended into a single, surviving Place Note.
ii. If the Place Notes are 100% identical to each other, only one copy is retained
All Media, Tasks and WebTags from all Places selected to be merged are retained
f.__All Place Details from all Places selected to be merged are retained:
i. If the same Place Details name exists in more than one of the selected Places being
merged, they are not merged as part of a Place Merge and must be merged using the
“Merge Place Details” tools.
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3. Merge Places tool:
a. The Merge Places tool can be initiated by either:
i.  Selecting the “surviving” Place, clicking on the “More Options (3 dots)” icon and
selecting “Merge Places”
ii. Or, Hover over the “surviving” Place, right-click and select “Merge Places”
b. After merging Places, | recommend checking:
i. Review the resulting Note data field and cleanup any merged Notes as desired
ii. Review the resulting Place Details for the “surviving” Place for any duplicate (exact, or
typos) or unused entries needing cleanup
4. The Merge Place Details tool works the same as the Merging Places tool, except that it can only
be initiated from the More Options (3 dots) icon
MAPPING
1. RootsMagic only displays a location marker on the Mapping View map when:
a. Places have their Lat/Long entered or, when the Lat/Long fields are blank and RootsMagic
has “confidence” it knows what the location is
i. Although RootsMagic may be confident it knows what the current day location is, be
aware that it is possible it is wrong
b. Place Details are only displayed if the Lat/Long data has been entered
2. Navigating within the Map
a. Location markers are labeled with the smallest geopolitical division entered for the Place
name
i. Hovering over the location marker will display the full Place name
ii. Clicking on the dot opens a popup window that lists the Year, Event Name and Person.
(1) The Events are listed in chronological order, based on the Fact Sort Dates, for all
Events that occurred at that Place location
(2) Entries with a blank Year, that are listed somewhere above the last Date entry,
have a Sort Date entered
(3) Entries with a blank Year, that are listed at the bottom don’t have a Date, and may
not have a Sort Date entered
b. You can zoom in/out by either:
i. Using the Zoom In (+ magnifier)/Out(-magnifier) icons
ii. Or, the mouse scroll wheel, if you have one
c. _You can move the Map to view areas not being displayed by clicking on the Map & dragging
it to a different location within the display area
3. When using the Map People (Events), when you use the Edit Person (pencil) icon to open the

Person’s Edit Person window, unlike when opening it from the PEOPLE PAGE, this window must
be closed before you can do anything else within RootsMagic

GEOCODING PLACES

1.

When Geocoding non-USA Places, | recommend you refresh your memory by re-reading the

“Approximating Places Not Found” portion of the Geocoding webpage found in the Online Help
Geocoding Places can be performed two ways in RootsMagic: using the built-in tools or

manually using 3™ party tools
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3. Place Details must be Geocoded manually using 3" party tools

4. Built-In Geocoding tools:

a. The built-in tools rely on the internal Places database that is installed as part of the program

to recognize Place names and correlate them to their current day Place (Standard) names

and Latitude and Longitude data

Note: The PlaceDB file is dated 2006 and does not get updated, so the “current day”

Place names may not be current if the local geopolitical divisions have changed since
2006
This also means that any errors in the file have never been corrected, so there is always

the low probability of an error in the information for a Place you are working with

b. The “Geocode Selected Place” tool:

You will only be successful using this tool if the selected Place appears in the small map

on the right side
Can be initiated by either:

Select Place, then click on More Options and select “Geocode Selected Place”

Or, hover over Place name, then right-click and select “Geocode Selected Place”

If RootsMagic doesn’t enter Geocode data into the Standard and Lat/Long data fields, it

Vi.

means it could not determine the Place’s current day location with confidence
If it doesn’t get Geocoded and the historical Place name is correct, the next steps are

to:

(1) Look up the Place name in the Gazetteer to see what the confidence scoring results
are.

(2) Use one of the other options to identify and enter the appropriate Geocode data

C. The “Geocode All Places” tool:

Places that already have Lat/Long data entered are skipped when this tool is used

Since a lot of data may be modified when this tool is used, | recommend making a

backup before proceeding with the Geocoding All Places tool
After running the tool, the “Match Places” window opens listing all Places that were

not Geocoded:
(1) A counter showing the number of Unmatched Places is in the upper left
(2) Asvyou select an Unmatched Place in the list, the Place Name is loaded in the

Search field and the right-side lists all the possible locations stored in the PlaceDB
file that “might correspond” to that Place name along with a “confidence score” of
how close RootsMagic thinks it matches the Place being searched.

(3) Note: The list of possible locations is sorted alphabetically, by confidence level

score
(4) If you see the “correct” Place, you can select it and click on the “Accept Match”

button
(5) If not, you can modify the Place information in the Search box to see if you can find

the “correct” Place
(6) If the “correct” Place cannot be found with confidence:

(a) ltis best to leave the Place “Unmatched” by selecting it and clicking on the
“lgnore Place” button and then perform manual Geocoding to confirm the
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correct data later because once a Place has had Lat/Long data entered, the
Geocoding tools will stop attempting to Geocode it
(b) Note: Re-running the “Geocode All Places” tool will result in all “Ignored
Places” re-appearing in the ne “Match Places” window
(7)_When the “Close” button is clicked, all remaining “Unmatched Places” are

4

‘Ignored”

Manually using 3" party tools:

a. If you want to look at the same list of possible Places and confidence scoring that the

Unmatched Places list showed when attempting to “GeoCode All Places”, you just need to

open the Gazetteer tool and copy/paste the Place name into the search box

b. The following refers to Google Maps to indicate using a 3™ party map tool. Any online map

tool should be able to perform similar functions

c. _Manually Geocoding a Place or Place Detail requires two steps.

d. Step 1 — Determine the current day name of the historical place you want to Geocode:

| always start by pasting the historical Place name into Google Maps to see if it

recognizes what the current day location is
Next, | try just searching for the smallest geopolitical division to see what results are

presented
When | get multiple results that may be the Place, | switch to Wikipedia and the

FamilySearch Wiki to learn about the history of the Places I've identified
In order to determine the correct geopolitical divisions, | also turn to Wikipedia and the

history of the local division changes over time
When the Place is in a foreign country, | use the Wikipedia site that is available in the

Vi.

native language for the country because the history of the location is likely more

thorough
Enter the current day location in the “Standard” data field, including the current day

geopolitical divisions

e. Step 2 — Determine the Latitude and Longitude for the Place or Place Detail and enter it in

the Lat/Long data fields:

Once the current day location has been determined, | use Google Maps to view the

location
| zoom in as necessary, especially when | have a Place Detail for a specific street

address, building name or cemetery to locate the exact map location | want to use for

Geocoding
When you right click on the location pin, the Lat/Long is displayed. If you click on the

Lat/Long, it is copied to your clipboard
To add the Lat/Long to the Place or Place Detail data field:

(1) If the Lat/Long fields are blank:
(a) Paste the copied data into the Latitude data field
(b) With both the Lat & Long data in the Lat data field, you can either:
i Click on the checkmark, or click on another Place and the data is split into
the two data fields and saved
ii. Or, press the Enter key, which causes the data to be split and shown in
the Lat & Long data fields. The data won’t be saved until the checkmark
is clicked, or another Place is selected
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(c) Note: If the Long field is not blank, when you paste the Lat/Long data into the
Lat data field and save it, the Lat will be saved in the Lat field, but the Long will
be change
(2) If there is existing data in the Lat/Long data fields, you just need to paste the
Lat/Long data into both data fields and save it. RootsMagic will keep the Lat data
for the Lat field and the Long data for the Long field
Note: If recording individual cemetery burial plots:

i. You may need a more accurate GPS device than a cell phone as they are only accurate
to ~10-30 ft. A handheld GPS device is typically accurate to ~10 ft

ii. Treating individual burial plots as Place Details may result in a large number of Place
Details being created. An alternative approach would be to use a Place Detail to
Geocode the cemetery and place the burial plot Lat/Long in the individual’s Burial Fact
Note; or create a Custom Fact for Burial Plot and place the Lat/Long in the Fact

Description

If you want to have a link to an online map that opens to the Geocoded location, you will need

to consider:

a. The Lat/Long data fields are not accessible for use within RootsMagic, except in the Place
List report

b. When using Google Maps, to properly capture the URL you must click on the Share button
and copy the link from there. Don’t use the URL displayed for the browser webpage because
it doesn’t capture enough place specific information to directly open to the displayed
location

c. _You can add a WebTag containing the URL to a Place, Place Detail, Fact Source Citation or
Person. Unfortunately, WebTags are not included in any reports except the WebTag List
report

d. You caninsert the map URL in the Burial Fact Note so it can be included in Narrative

Reports, if desired
i. Note: If you place the URL in a Note inside curly brackets, its flagged as Private Note

Data, and will only be included in published reports if you select Private data to be
included

To create a list of all Places that are currently NOT Geocoded, run the TOOLS > Enahanced

Properties tool and then locate the “Places Not Geocoded” entry and click on “View”

A list of all Place Details that are currently NOT Geocoded cannot be created. The only way to

check the Geocoding status of Place Details is to view each Place’s Place Details list on the

PLACES PAGE

REVERSE PLACES

SPLITTING A PLACE

1.

When you use the “Split Place” tool and the resulting Place and Place Details already exist, you

may end up with a duplicate Place Detail for the Place. Each Place Detail will be used by the

items that were using it prior to using the tool. If the resulting Place Detail is an actual duplicate,

it will need to be cleaned up by merging it with the pre-existing Place Detail

There isn’t a built-in tool to perform the reverse (merge a Place Detail with a Place). A Tech

Savvy user developed an external script using 3rd party tools that can perform this outside of
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RootsMagic: https://sqlitetoolsforrootsmagic.com/places-conversion-of-place-details-to-
places/?fbclid=IwY2xjawMBISZleHRuA2FIbQIxMABicmIkETFGSDFtQXpsNOMzRHZYRjIBARANR97K
1TZMIHEBgZN5GSo5mCWsPDdPrg NYYm8U84IdJY 2VQnXXt8usyl8A aem Hig4ywlJKpSn-

xad3rwpthw

GAZETTEER

1.

The Gazetteer uses the same PlaceDB file used for Geocoding.

a. It contains the same set of data originally released in 2006.

b. No corrections have been made to it.

c. lrecommend you become familiar with the localities you work with so you can evaluate the
results of using the tools to ensure they are identifying the correct, current day location for
each historical Place in your database file

2. The Gazetteer can be accessed three ways:
a. Onthe PLACES PAGE, click on the More Options (3 dots) icon and select Gazetteer
b. Or, open it from the TOOLS PAGE
c. _Or, when entering a Place for a Fact or Association, when you click on the Place data field a
small Gazetteer icon (magnifying glass with a map) appears at the far right of the data field
3. Asyou enter a Place in the search box, the list and confidence scores appear below
4. When you select a Place from the list:
a. Clicking on the View Online button opens up Bing Maps in your default browser and displays
the selected Place
b. Clicking on the Paste to Place button while on the PLACES or TOOLS PAGE does nothing.
However, when on the Edit Person window, entering a Fact or Association, clicking this
button will enter the selected Place into the Place data field
COUNTY CHECK
1. Although introduced with the release of v5 in 2011, | believe the same PlaceDB file used for the
Geocoding and Gazetteer tools, dated 2006, is also used for the CountyCheck tool. Therefore,
any geopolitical changes the occurred after the 2005/6 timeframe are not identified
2. Asareminder:
a. CountyCheck only evaluates the historical presence down to the County (third) level
b. CountyCheck only works for locations in the United States, United Kingdon, Canada and
Australia
c. Over the years, a few errors have been identified, which as I've mentioned have not been
corrected with the release of an update to the PlaceDB file
3. The CountyCheck Explorer can be initiated by either:
a. On the PLACES PAGE, click on the More Options (3 dots) icon and select CountyCheck
b. Or, open it from the TOOLS PAGE
4. The CountyCheck Explorer Search field:

a. Only provides a list of possible Places AFTER the complete geopolitical division has been
entered.

b. If you enter more than one division, CountyCheck evaluates each entry separately and
together. It returns a list of possible Places that contain one or more of the divisions being
searched
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i. Common location abbreviations are recognized
ii. Alternative names of some locations are recognized
iii. Even though only Places down to the third level are supported, if more than three

levels are entered in the search, each separately entered division is still evaluated as a
possible level 1 to 3 division

5. Data provided for each listed Place:

a.

Place: Possible result based on Search entry

b.

Type: Division level of selected Place

< & >icons: Used to navigate back and forth through the history of Places viewed in

CountyCheck

. Created:
From:

Contributed To: Indicates what places were created from the selected Place

Eliminated: Indicates when the selected Place you’re looking at ceased to exist

@ e e

Known As tab: Lists in chronological order what the Place was called over time, what type of

Place it from and to what dates
Belongs To tab: Lists what the Place’s next higher division is

Contains tab: Lists what divisions make up the selected Place, what Type of division it was

and from and to what dates
Info button: Opens the FamilySearch Wiki page for the currently selected Place in the

default web browser
Map button: Opens one of several different websites in the default web browser to view

map data for the selected Place. I’'ve seen Newberry Library, Wikipedia, FamilySearch Map
of English Jurisdictions

6. CountyCheck can also be activated to evaluate Place names based on the event date as they are

about to be saved while entering Facts and Associations:

a.

To activate: SETTINGS PAGE > Program Settings View. “Use CountyCheck When Entering

Places” checkbox
The 1% three divisions of Fact or Association Place name entry are evaluated, along with the

event date, when it is about to be saved
When CountyCheck believes there may be an issues with the Place name about to be

entered, based on the date of the event, the CountCheck Suggestion window opens
Recommended changes identified by CountyCheck are presented for consideration prior to

saving the Place name
Additional information can be viewed by selecting a suggestion and clicking on the More

Info button, or clicking on the hyperlink for one of the divisions to open the CountyCheck

Viewer window which is similar to the CountyCheck Explorer window, without the search

capability
The decision to keep the original Place name as entered or accept the recommended change

is always left to the User

UNUSED PLACES

1. When selected, Places listed and any Place Details that may also exist for the Place are not used

anywhere in the database file and can be safely deleted, if desired
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If many unused Places are deleted, it may be a good time to run the TOOLS PAGE > Database

Tools > “Compact Database” tool
RM9, Unused Places must be deleted one at a time

RM10, Added the capability to delete more than one Unused Place at a time using TOOLS PAGE

> Other Tools > Enhanced Properties List > Places: Unused Places > View
Place List report:

a. The Place List report can be generated from both:
i. The PLACES PAGE > More Options
ii. The PUBLISH PAGE > All Reports And Charts
b. The Unused Places List can only be generated from the Enhanced Properties List
i. There isn’t a capability to generate a list of Unused Place Details since all Unused Places
only have Unused Place Details associated with them
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REPORTS AND CHARTS

https://help.rootsmagic.com/RM9/reports-and-charts.html

https://help.rootsmagic.com/RM10/reports-and-charts.html

REPORT VIEWER

REPORT SETTINGS

CHARTS (LARGE FORMAT)

CHARTS (REPORTS)

FORM REPORT

1. Leeds Method Report:

a. The colored boxes in the report with the filled-in black dot are the Matches initially
assigned that color

b. When the report is saved to an Excel file, the colors are not included, but the filled-in and
non-filled-in dots are included.

c. When the report is saved to a CSV file, the colors are not included, but the filled-in and
non-filled-in dots are represented by character strings, which will need to be replaced with
a more recognizable symbol after importing into the destination software.

LABELS
LIST REPORTS

1. CountyCheck List:
a. Reminder: CountyCheck only evaluates the 1% three divisions of a Place name
b. This report is organized by Person and the Places used in their Facts; it’s not a list organized
by Place name
c. When “Everyone” is included, the report can take a long time to generate
When included, the Matches option lists not just places needing minor corrections, it also

includes Places that require no correction
2. DNA Kinship List:

a. Note: If relationship links have been added after initial entry of the DNA matches to be
included, you may want to consider updating the Tree Relationship for each DNA Match
that currently does not have a Tree Relationship to ensure the latest known information is
reflected in your report.

b. “Has DNA Match” checkbox: When this checkbox is checked, the report will include people
that have a DNA match with the selected person. Unchecked, it will exclude people with
DNA matches

c. ”No DNA Match” checkbox: When this checkbox is checked, the report will include People
that don’t have a DNA match, but do have a Tree Relationship. Unchecked, it will exclude
everyone that doesn’t have a DNA Match

NARRATIVE REPORTS
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CUSTOM REPORTS

RESEARCH REPORTS

REPORTS NOT IN PUBLISH PAGE
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TOOLS

https://help.rootsmagic.com/RM9/tools.html

https://help.rootsmagic.com/RM10/tools.html

MERGING DUPLICATE PEOPLE

PROBLEM SEARCH

DATACLEAN

1.

The DataClean tools can make changes to multiple entries in your database. It is recommended

that you make a Backup file prior to running these tools in case you decide the results are not
what you expected
The DataClean tools only make changes that you decide to “approve”. It is up to you to decide

whether to review each proposed change or have RootsMagic make changes without your
review of each one.

NameClean

PlaceClean

1.

Using accurate, properly spelled and consistent Place Names is a key housekeeping task that

helps reduce having multiple Place names for the same location in your database resulting from:

a. Merging of duplicate People with the same Facts but difference in the Place data field

b. Typos and other data entry errors introduced by not selecting an existing entry in the Place
List

c. Importing data from other sites and files with different Place naming conventions

Place Clean can be initiated from the PLACES PAGE > More Options(3 dots) icon and selecting

DataClean. It can also be initiated by initiating the DataClean tool from these locations:
a. On the People Page > Tools icon > Dataclean

b. On the Tools Page > DataClean

c. Command Palette > DataClean

The PlaceClean tool is always run on all the Places in the database file

The tool options are:

a. Problem —Select as many, or as few Problems you want the tool to flag when it is run

i. Note: If you have elected to include more than 4 levels of divisions in your Place
names, you may want to consider unchecking the “Misplaced Place Details” checkbox
b. Add or Remove Country — Allows you to modify a specific country name each time the tool is
run. Although United States & USA is pre-entered, you can enter anything you want
c. Replace <Brackets> - Allows you to modify a specific section of a Place name enclosed in

brackets with other text

d. After the tools is run, the above settings are remembered for the next time you run the tool.
Therefore, always review these settings before running the tool

The tool results appears as follows:

a. 4 Columns:
i. Empty Checkboxes — Only rows that get checked will be changed
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(1) The “conservative approach” is to leave all unchecked and one-by-one review and
verify every suggested change to ensure they are “verified” first and then checked
(2) The “riskier approach” would be to start by checking all the boxes and still try to be
rigorous in evaluating the suggested changes, but only have to uncheck those few
where you don’t want to make the suggested change, thus saving time and effort
ii.  Original Place Name — This shows the current Place Name entered in the database
iii. Cleaned Place Name — This shows the proposed new Place Name after it has been
“Cleaned”
iv. Cleaned Place Details - This shows the proposed new Place Details entry that will be
created as a result of “cleaning” the identified “Misplaced Place Detail”
(1) Note: Any Place name that has more than 4 levels of divisions will be identified as
having a “Misplaced Place Detail” and PlaceClean will recommend moving the 5th
(and lower) divisions to the Place Details data field
b. Below the list of suggestions, the 3 data fields for the selected Place in the list. You can edit
the suggested “Cleaned Place” and “Cleaned Place Details” data fields here.
c. At the bottom of the window, the “Problems to Fix” area lists the types of Problems the tool
has identified for the selected Place in the list
i. You can unselect any listed Problem to see what the suggested Cleaned Place Name
should be
d. Make sure to check the checkbox of each reviewed Place you want changed before
proceeding
e. To make the selected changes, click on the “Clean Checked Places” button
6. The PlaceClean tool does not check for duplicate Place or Place Detail entries when cleaning up
Place names.
a. _After running the PlaceClean tool, | recommend reviewing the list of Places on the PLACES
PAGE for duplicate Place entries that need to be merged using the “Merge Places” tool
b. If you created new Place Details, these may also be duplicates that need to be merged using
the “Merge Place Details” tool

COUNTING TREES

CALCULATORS

CALENDAR
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ONLINE FEATURES

https://help.rootsmagic.com/RM9/online-features.html

https://help.rootsmagic.com/RM10/online-features.html

MYROOTSMAGIC
HTML WEBSITE
ANCESTRY TREESHARE
FAMILYSEARCH

1. FamilySearch Person Tools
a. Share Data With FamilySearch:
i. RM10, When they exist, you can share a matched person’s FamilySearch “Brief Life
History” with the person in your RootsMagic database file.
(1) When brought into your database, the information is placed in a “Life Sketch” Fact
(2) The 1st time a Life Sketch Fact is added to your database, a new, Custom Fact Type
(Life Sketch) is added to the file’s list of Fact Types
(3) The information is placed in the Fact’s Description field
(a) Reminder, the Description field is recommended to contain no more than 100
characters
(b) You may decide to move most, or all, the Life Sketch text to the Fact’s Note
field. If you choose to do this to ensure no loss of data when exporting it, be
aware that the FamilySearch Person Tool will show that the version in
RootsMagic is different compared to the version at FamilySearch

LDS FEATURES

WEBTAGS
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ENTERING INTERNATIONAL CHARACTERS

GENERAL

1.

RootsMagic supports Unicode characters:

EMOlls

1.

https://en.wikipedia.org/wiki/List of Unicode characters

Emojis are a unique character set that can be inserted like International Characters anywhere

that text can be entered. However, they are treated differently in RootsMagic. Currently:

a. Emojis appear in RootsMagic Charts and Reports as blank spaces

b. Emojis can be transferred via TreeShare to an Ancestry tree

c. Saved searches that include emojis do not work when re-used and RootsMagic Tech Support
recommends not using them as a search filter.

d. Tech Support reports that some emojis have been found to cause issues with some reports
and may cause a GEDCOM export to fail

It is recommended that you refrain from inserting emojis into a Person’s Given or Surname

because they will affect the results received back from any WebHint or online site searches that

include them.

Your operating system Emoji keyboard can be activated by pressing Windows key+”.”(period) on

Windows, or Ctrl+Cmd+Space on Mac computers.

Another option is to find, copy & paste them in from an emoji website, such as:

https://getemoji.com

Once entered, they cannot be turned on/off for different activities. Therefore, careful

consideration needs to be taken before deciding to add emojis into your database.

a. Ifinserted in a Fact, inclusion of the Fact Type can be turned on/off by editing the “Include”
settings for the Fact Type.

b. If the “Reference No” Fact Type is used for emojis, they can be displayed after a person’s
name in RootsMagic in place of the RIN (record identification number) or FSID (FamilySearch
Identification) by changing the setting found at:

i. Setting > General Settings > “Number To Display” to “REFN”
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OTHER INFORMATION:
Resolving known problems:

1. If you are using a Mac and get the “Unexpected Error Instance of “Tabulmage” not created”
error message, some users think it is caused by the presence of unacceptable special characters
in 1 or more media file names and/or folder paths. However, RootsMagic has not been able to
confirm this is the “real” cause of the issue and therefore do not have a guaranteed fix yet. To
see if special characters are causing your issue, the steps to try and recover are:

Perform steps above to Force Quit RootsMagic

Rename the database if it is set up to open automatically when RootsMagic is started

Start RootsMagic

Open the renamed database

Make a backup in case you want to revert back

Go to the Media Page

Optional, you may want to create a Multimedia List report to track which files require

modification
h. Under More Options (3 dot icon), select Search and Replace
i. Search the Multimedia Filenames in the database for the following special characters and

replace them, one at a time:
i. #, S, commas,doublespaces, (,), {, }, !, *, and any other unusual special character
symbol, like a square box
j.  For each character found and replaced, perform the same to rename the Media files using
FINDER to highlight all names under the MEDIA directory:
i. Choose RENAME from the FINDER File menu
ii. Repeat finding and replacing each special character found in the database.

2. If you share a database file between Mac and Windows computers, you may experience a
compatibility issue on initial use. Running the Test Integrity Database Tool reports errors. The
problem can be rectified by running either the Rebuild Indexes or Compact Database Tool, all
found on the TOOLS Page.

@ -0 o0 T o

Technical Information:

1. User Settings File:

a. RootsMagicUser.xml — Each time RootsMagic is closed, all program-level setting information
is written to this file for use the next time RootsMagic is started. The information includes
User set options, window sizes, screen divider bar position information and lists of recently
used files & folders. If set to remember them, Ancestry and FamilySearch UserNames and
Passwords are stored in encrypted form too.

b. Location:

i. OnaWindows PC, the file is located in the “Users > "yourusername” > AppData >
Roaming > RootsMagic > Version 9” folder. Note that the AppData folder is hidden.
ii. Ona Mac, a search of the hard drive should locate this filename.

c. This xml file can be viewed (but not edited) in any web browser.

d. If for some reason you desire to edit the data, you can open it in any text/word processor
software. However, the file does not contain sufficient formatting information for these
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programs to present the information in an easy-to-read format. It is recommended to open
the file in a web browser for easy reading and location of specific data to be changed and a
word processor to search for and edit the desired text.

At this time, the information stored in this file are the last settings of the various
window/form locations and sizes, selected settings, recent files & folders, etc just prior to
closing the program

You can replicate all of your settings onto another computer by placing a copy of this file in
the correct location prior to opening RootsMagic.

Problem Solving Information:

1. Learning how a feature or tool works:

a.

The first step to learning about any new tool is to play with it and your ideas for using it in a
test database to make sure you understand how things work before you use it with your
main research database.

There are 2 different ways to approach creating test databases:

i. Create a small database, you could even Drag & Drop a couple of generations of your
main database into a new, empty, file. Use the small database to test and learn how a
tool works, or doesn’t.

(1) File > Create a New RootsMagic File > Empty File
ii.  Or, just make a copy of your entire database that you give a new name that clearly
identifies it as a test database. Using a copy of your main database to test and learn how
your actual data will be affected:
(1) File > Tools > Copy
(2) Decide where to put it
(3) Give it a name that makes it clear what it is
(4) Save the file
(5) Make a Backup of the copied file so that you can use “File > Restore From Backup”
to Restore it whenever you want to reset your test database while testing things
Play with the tool and how it behaves using the test database first, confirming your
understanding of how it works. In addition to the Online Help, you can find information
about the existing features and new capabilities as they are released here:

i. Links in the Help and Support Section on the software program’s Home Page

ii. The RootsMagic Community, which is viewable by the public, even without an account.
You only need an account if you want to post. You may also need one to keep track of
which postings you have read and which are new.

iii. At our monthly SIG meetings, Open Q&A and SIG email

iv. If you’re a member of the Private RootsMagic Users Facebook Group, there’s always a
lot of posts about new features recently added to the program and questions about
how to do things

2. Using the filter search criteria window to create Boolean Logic filters is one of the more
powerful tools in RootsMagic in terms of being able to find People that meet a specific set of
criteria for your task or problem.

a.

But it can appear difficult to use if you try to write and apply a string of conditions all at
once and are surprised the resulting list is not what you expected
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The effect of using both the AND & OR connectors in the same filter criteria can sometimes
create unexpected results

Understanding what the filter field criteria are actually looking at is important

Working out the complicated filters incrementally as a series of simpler, shorter, filters is a
good technique to avoid some frustration and will usually help point to where things may
not work the way you were expecting them to

3. Resolving “linking issues” — Linking issues typically appear in one or more of the following forms:
duplicate People with same RIN (record ID number), children from same family not linked to the
same Parental Couple, and/or known Spouses shown as “Unknown Spouse” in the Descendant
View).

a.

Note: If you determine the original cause was due to data you brought into your RootsMagic
file via the Ancestry TreeShare or FamilySearch tool, it is recommended you fix the issue at
those sites and bring the changes into your file rather than fix it in RootsMagic and attempt
to push the fix back to the online site that caused the original problem.
You can analyze and correct most linking issues by performing the following steps in the
order listed:
i. Runthe 4 Database Tools found on the Tools Page to ensure there are no internal
database issues
ii. If not already displayed, turn on the display of each person’s RIN:
(1) Settings Page > General Settings > Number to Display = RIN
iii. If yousee duplicate people, with different RINs, these are separate duplicate people in
your database that should be Manually Merged and the merged information cleaned
up
(1) People Page > Tools icon > Manual Merge
iv.  With your initial person of interest selected, switch to the Descendant View and set the
number of generations to display to “2”
(1) Reminder: All relationship links are either Parents (a Couple) to a Child or Spouse to
Spouse.
v. Analyze each “family” defined in the database for this person. Determine which people
are shown in incorrect “families.” Look for:
(1) If you see the same Couple listed more than once:
(a) Open the Person’s Edit window and look for multiple Marriage Facts for the
same Couple.
(1) The same Child appearing under more than one Couple (Person and Unknown
Spouse and/or Person and same Spouse)
(a) Cause: Child linked to more than 1 set of Parents
(b) Solution: Unlink incorrect Parents from Child
(1) Some Children listed under one Couple and other Children born to the same
Parents listed under a different Couple
(a) Cause: Children were not linked to the same Couple
(b) Solution: Link all Children to the same Couple in database and Unlink them
from the other sets of Parents (user preference whether to Link/Unlink or
Unlink/Link).
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(2) Couples you did not expect to see, including having an Unknown Spouse and no
Children
(a) Cause: Either incorrect Spouse link applied, or Child was linked and

subsequently unlinked
(b) Solution: Unlink from Spouse

Once you have determined which person and relationship needs to be corrected, select

one of the Parents and switch to the Family View to ensure both you and RootsMagic

are focused on the same Family relationships before performing the appropriate
solution.

(1) Link/Unlink relationships in this family as necessary.

(2) Remember: The Unlink Family Members choice can be used when you want to
unlink all Children from the Parents and unlink the Parents from each other for the
Family displayed in the Family View

Repeat, starting at step iv, until all bad links have been corrected and the Family is

properly depicted in the Descendant View.

(1) Note: If you have a multi-generational issue, you will need to shift the Descendant
View 1 generation up/down to analyze and correct bad links within that Family.

Upgrading from prior versions of RootsMagic:

1. Upgrading from RootsMagic v7 or earlier:
a. Contact the GFO RootsMagic SIG facilitator for the most current recommendations
2. Upgrading from RootsMagic v8 to v9 or 10:
a. If you are transitioning from RootsMagic v8 to v9 or 10, review the following before
proceeding with the actual installation and conversion process:

RootsMagic v9 and v10, install on your computer as a different software programs.
When ready, you uninstall version 8 as a separate action

When you initially open a v8 database file, it is “converted” to be compatible with v9.
Once afile is “converted”, it can no longer be opened using RootsMagic 8. If it is
desired, you must make a copy of the v8 database file and rename it or place it in a
different folder in order to keep a v8 file that can be used with RootsMagic 8.
Otherwise, make a backup of your v8 file and edit the filename to indicate it was the
last backup prior to converting to v9 or 10

b. Install the RootsMagic program, but do not open any files yet
Select the SETTINGS Page and at a minimum set the Data Folder Settings to point to where
each type of data is located. Normally, these would be the same folder locations as your
prior version of RootsMagic, with the possible exception of the Data Folder if you have
decided to place your v9 or 10 database file in a different folder than your v8 file
Now open the database file you intend on converting to use with v9 or 10
If you have used Color Coding in your v8 file, it has been assigned “Color Code Set 1” in the
“converted” v9 file. You should assign the Color Code a meaningful name and review the
colors used and consider giving them labels where appropriate

3. Upgrading from RootsMagic v9 to v10:

a. If you are transitioning from RootsMagic v9 to v10, review the following before proceeding

with the actual installation and conversion process:
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i. RootsMagic v10 installs on your computer as a different software program. While
installing v10, the installation program will recognize that you have an earlier version of
RootsMagic installed and offer to uninstall it for you. This choice is up to you. In most
cases, users have no intention of using both programs in the future and would choose
to have the earlier version uninstalled. The recommended first steps are different
depending on which option you intend on selecting when you install v10:

(1) If you plan on keeping v9 installed, you will want to make a copy of your v9
database file(s) and assign them a different filename to clearly indicate they are
intended for use with v10. If your v9 files are not labelled to clearly indicate they
are intended to be used with v9, you may want to rename them as well at this
time. You may also want to place your v9 and v10 files in separate Data folders,
where neither folder is a sub-folder of the other

(2) If you don’t plan on keeping v9 installed, you should make a backup of your v9 file
and add something to the filename so that you know it was the last backup before
converting the database to v10.

ii.  When you initially open a pre-v10 database file in v10, it is “converted” to be
compatible with the new v10 (internal database tables). Once a file is “converted”, it
can no longer be opened using RootsMagic a prior version of RootsMagic

iii. If you are not confident that you won’t “accidentally” open the v9 file in V10, you
should consider placing either or both different version database files in different
folder locations, where neither file type is in a sub-folder of the other file type.

b. Install the RootsMagic v10 program, but do not open any files yet

Select the SETTINGS Page and at a minimum set the Data Folder Settings to point to where

each type of data is located. Normally, these would be the same folder locations as your

prior version of RootsMagic, with the possible exception of the Data Folder if you have
decided to place your v9 or 10 database files in a different folder than your prior version.
d. Now open the database file you intend on converting to use with v10
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